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1. Về tập tài liệu này 

Cũng như các tài liệu tham khảo phần mềm tin học hiện nay, tôi 
chỉ là người biên soạn chứ không phải tác giả. Mong ý kiến đóng 
góp của các bạn để tài liệu tốt hơn. 

Tài liệu được biên soạn dựa trên  

• Help File, Tutorial, Video Tutorial của SketchUp 5.0. 

• Kinh nghiệm thực tế. 

Quan niệm trình bày 

• Tài liệu biên soạn trong ngữ cảnh của ngành kiến trúc. 

• Ngắn gọn! Những kiến thức căn bản sẽ được lướt qua. 
Chẳng hạn ai cũng biết một công cụ có thể kích hoạt từ 
Thanh công cụ, Thanh menu hoặc Phím tắt. Tôi cung cấp 
phương pháp còn hướng đi là của các bạn. 

• Thực tế! Những tính năng trùng lặp hoặc ít dùng trong 
kiến trúc sẽ được lược bỏ. Trong tài liệu, cần lưu ý các 
biểu tượng sau: 

  Chú thích thêm  

  Thủ thuật 

  Chú ý 

Sử dụng tài liệu như thế nào? 

• Nên có kiến thức căn bản về máy tính – đồ họa trước khi 
học bất kì phần mềm đồ họa nào, SketchUp cũng vậy. 

• Tài liệu này chỉ hỗ trợ giai đoạn đầu. Muốn phát triển kĩ 
năng cao hơn các bạn nên tham khảo website 
www.sketchup.com. Ngoài ra, mọi sự tham khảo chỉ có 
giá trị khi bạn thực sự ứng dụng trong thực tế. 

 Tài liệu này dùng tham khảo nội bộ 9X9. Tuy phi thương mại, nhưng 

nếu có sử dụng lại ở bất kì đâu, xin định rõ nguồn gốc. 

MÔÛ ÑAÀU 
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2. Về phần mềm SketchUp 

SketchUp là phần mềm đồ họa 3D do hãng @Last Solfware phát 
triển, chuyên ứng dụng vào thiết kế sơ phác, xây dựng mô hình 
trong các lĩnh vực kiến trúc, nội thất, cảnh quan, xây dựng, thiết 
kế cảnh quay trong điện ảnh, thiết kế sân khấu. 

Ứng dụng đồ họa 3D trong các giai đoạn thiết kế kiến trúc là xu 
hướng tất yếu. Nhưng : 

• KTS, sinh viên kiến trúc ngày càng phải đầu tư vào kĩ 
năng sử dụng máy tính, trong khi vẫn còn nhiều kĩ năng 
quan trọng khác. 

• Các phần mềm 3D nổi tiếng hiện nay rất chuyên nghiệp 
và xuất sắc ở giai đoạn thể hiện chi tiết ý tưởng với hiệu 
quả chuyên sâu về ánh sáng, vật liệu. Nhưng ở giai đoạn 
sơ phác ý tưởng, trình diễn sơ bộ với khách hàng hoặc 
thảo luận nội bộ nhóm thiết kế … chúng trở nên nặng nề 
không cần thiết và kém thích ứng. Các phần mềm này 
thường phức tạp và đòi hỏi đầu tư đào tạo rất cao. 

Nhận biết điều đó, SketchUp được phát triển theo 2 xu hướng: 

a. Đơn giản nhưng Hiệu quả  

Đánh giá trên cùng một hiệu quả mang lại, SketchUp là phần 
mềm 3D dễ học, tốn ít công học. Có thể có phần mềm dễ hơn 
nhưng sẽ quá thô sơ hoặc không khả thi. 

Để đơn giản và hiệu quả, SketchUp trực quan hóa mọi hoạt 
động tương tự như khi vẽ tay. Đơn vị cơ bản trong SketchUp là 

đường – mặt với chuỗi thao tác vẽ, chia, nối, di chuyển, xoay, 
thu phóng, nâng khối, cắt khối, trượt dẫn, tô màu, áp vật liệu, vẽ 
địa hình, thêm cảnh quan, giả lập bóng đổ, xuất ảnh, làm slide 
show … các hoạt động này đều trực quan trong môi trường 3D. 
Mọi tính năng chỉ được xây dựng vừa đủ dùng nhưng khả năng 
thể hiện ý tưởng sơ phác khá hiệu quả. 

b. Nhanh nhưng Chính xác 

Do đơn giản nên người dùng SketchUp có thể vẽ rất nhanh, 
nhưng không có nghĩa kém chính xác. SketchUp có khả năng dò 
điểm nội suy, nhập liệu tới chính xác 6 số lẻ phần thập phân, giả 
lập bóng đổ theo thời gian thực, tạo mặt cắt tương tác … 

 

 Hãy đặt SketchUp vào đúng vai trò của nó trong giai đoạn 
sơ phác. Một công cụ nhẹ nhàng và hiệu quả cho một mục đích 
xác định chứ không phải công cụ toàn năng. 
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3. Có gì mới trong phiên bản SketchUp 5.0 

• Nhóm công cụ Sandbox nhằm tạo và hiệu chỉnh bề mặt 
địa hình hoặc mặt lưới tam giác hóa bất kì, vốn rất hạn 
chế trong các phiên bản trước đó. Theo hãng sản xuất, 
Sandbox còn có thể tạo các mặt cong hữu cơ, thậm chí 
cả mặt người. Tất nhiên không thể có hiệu quả như các 
công cụ chuyên biệt của 3ds Max, Maya hay Rhino. 

• Extension Manager dùng để tắt bật các tính năng mở 
rộng – ít dùng của SketchUp (như nhóm công cụ Sandbox 
chẳng hạn) nhằm đơn giản hóa giao diện người dùng 

• Khóa Component và Group để không vô ý di chuyển 
hay chỉnh sửa. 

• Kiểu hiển thị nét có thêm tùy chọn Depthcue (nét gần 
dày nét xa mảnh) và tùy chọn Endpoints (nhấn hai đầu 
nét). Ngoài ra bạn có thể tắt mở hiển thị toàn bộ nét trong 
mô hình. Các phiên bản trước đây tắt mở nét phải gián 
tiếp qua lệnh Hide/Unhide rất thủ công. 

• Component Outliner giúp bạn quản lí theo cây phả hệ 
các Group và Component đã dùng trong mô hình. Rất 
hữu ích khi vẽ một mô hình lớn 

• Giao diện người dùng được thiết kế lại với các icon và 
con trỏ chuột mới 

• Kiểu file nhập vào và xuất ra hỗ trợ thêm một số chuẩn 
mới. Đầu vào có thêm 3D Studio (3DS), Digital Elevation 
Mode (DEM). Đầu ra có thêm (OBJ), (XSI) và (FBX). 

• Tương tác với Component có vài thay đổi. Trong hộp 
thoại Component Browser, menu động có thêm dòng lệnh 
Replace Selected để thay thế 1 component đã chọn 
trước trong mô hình bằng 1 component đang chọn trong 
hộp thoại. Khi chọn 1 component, menu động có thêm 
dòng lệnh Make Unique để ngắt riêng định nghĩa của 
component đó ra, không bị chỉnh sửa hàng loạt. 

• Công cụ Walk  mặc định nhận biết vật cản trước và sau 
camera, hạn chế việc đi xuyên vật cản. Có thêm tính tăng 
di chuyển trên địa hình mà không thay đổi điểm đích. 

• Hệ thống hộp thoại được sắp xếp dạng “stack windows” 
trong đó các title bar có thể neo với nhau, có thể trôi tùy ý 
trên màn hình. Có thể tắt bật toàn hộp thoại bằng phím tắt 
hoặc menu Show/Hide Windows. Muốn truy nhập hộp 
thoại nào chỉ cần click lên title bar hộp thoại đó. 

• Lệnh Push/Pull có thể kết hợp với phím Ctrl để tạo thêm 
hoặc chia đoạn mới, rất hữu dụng khi tạo sơ đồ không 
gian cho công trình 

• Hỗ trợ ngôn ngữ Ruby cho phép tạo các ứng dụng, 
plug-in của riêng mình trong SketchUp 

• Fractional Units là loại đơn vị thợ mộc ở Mĩ hay dùng 
cũng được hỗ trợ trong phiên bản này. 



  MÔÛ ÑAÀU 

 CHÖÔNG I: GIAO DIEÄN VÔÙI NGÖÔØI DUØNG 

 CHÖÔNG II: VEÕ CAÊN BAÛN 

1. Coâng cuï Veõ  

2. Coâng cuï Thieát yeáu 

3. Coâng cuï Quan saùt 

4. Coâng cuï Hieäu chænh 

 CHÖÔNG III: VEÕ NAÂNG CAO 

1. Noäi suy 

2. Khoùa höôùng 

3. Heä truïc toïa ñoä 

4. Coâng cuï Xaây döïng 

5. Coâng cuï taïo ñòa hình 

 CHÖÔNG IV: VEÕ COÙ HEÄ THOÁNG 

1. Quaûn lí Layer 

2. Quaûn lí Component 

3. Quaûn lí Outliner 

4. Thieát laäp vaø quaûn lí moâ hình 

CHÖÔNG V:  AÙNH SAÙNG, VAÄT LIEÄU, HIEÅN THÒ 

1. AÙnh saùng 

2. Vaät lieäu 

3. Hieån thò 

  PHUÏ LUÏC 

MUÏC LUÏC 



Hướng dẫn sử dụng SketchUp 5.0 Chương I – Giao diện với người dùng  Trang 1 

Drawing Area = Không gian vẽ 

1. Toolbars (Thanh công cụ) 

–

 
 
 
 

I. GIAO DIEÄN VÔÙI NGÖÔØI DUØNG 

Title Bar 
Thanh tiêu đề 

Menu Bar = Thanh menu 

VCB 

Origin = Gốc hệ trục 

Display Modes Toolbar
Các chế độ hiển thị 

Views Toolbar 
Các hình chiếu 

Status Bar 
Thanh trạng thái 

Standard Toolbar  
Công cụ Chuẩn 

Principal Toolbar  
Công cụ Thiết yếu 

Drawing Toolbar  
Công cụ Vẽ 

Modification Toolbar  
Công cụ Hiệu chỉnh 

Construction Toolbar  
Công cụ Xây dựng 

Camera Toolbar  
Công cụ Quan sát 

Walkthrough Toolbar  
Công cụ Bộ hành 

Drawing Axes = Hệ trục 



Hướng dẫn sử dụng SketchUp 5.0 Chương I – Giao diện với người dùng  Trang 2 

New = Tạo file mới 
 
Open = Mở file đã có 
 
Save = Lưu file 
 
Make Component  
= Tạo Component 
 
Cut = Cắt 
 
Copy = Sao chép 
 
Paste = Dán 
 
Eraser = Xóa 
 
Undo = Hồi lại lệnh 
 
Redo = Lặp lại lệnh 
 
Print = In file 
 
Model Info  
= Thông số mô hình 
 
Context Help  
= Hướng dẫn nóng 

Iso = Trục đo 
 
Top = Mặt bằng  
 
Front = Mặt Nam  
 
Right = Mặt Đông 
 
Back = Mặt Bắc  
 
Left = Mặt Tây 

Wireframe = Khung dây 
 
Hidden Line = Nét thấy  
 
Shaded = Tô bóng  
 
Shaded with Textture  
= Vật liệu và bóng 
 
X-Ray = Xuyên sáng 

Value Control Box (VCB) 
Hộp nhập trị số 

Nhập trị số và Enter để áp dụng lên 
công cụ hiện hành. Không cần click 
chuột vào vùng này khi nhập trị 

Nút trái 
Click = kích hoạt 

công cụ, chọn điểm, 
đối tượng, bắt điểm.  

Nút lăn 
Click rà = xoay nhìn 

Shift + Click rà = dời nhìn
Lăn = thu phóng nhìn 

Nút phải 
Click = menu động 

Shadow Toolbar = Công cụ giả lập bóng đổ 
Hộp thoại bóng / Tắt bật bóng / Tháng trong năm / Giờ trong ngày 

 Select = Chọn 
Shift = nghịch đảo 

Ctrl = thêm vào 
Shift+Ctrl = bớt ra 

Trái qua phải = chọn bao 
Phải qua trái = chọn cắt 

  

Move = Di chuyển 
Shift = khóa hướng 
Ctrl = sao chép 
Shift+Ctrl = bớt ra 
Alt = ép biến dạng 
VCB: nhập khoảng cách 

Paint Bucket = Tô 
Alt = lấy mẫu 

Ctrl = tô những gì nối liền 
Shift = thay thế toàn bộ 

Shift+Ctrl = thay thế nối liền 
  

Push/Pull = Kéo/Nén 
Click đúp = lặp lại trị số cuối 
Ctrl = sao chép đoạn mới 
VCB: nhập khoảng cách 

Eraser = Xóa 
Shift = tắt hiển thị 

Ctrl = làm mềm 
Shift+Ctrl = làm sắc   

Rotate = Quay 
Ctrl = sao chép khi quay 
VCB: góc, độ dốc 

Rectangle = Hình chữ nhật 
VCB: nhập dài, rộng 

  

Follow Me = Trượt dẫn 
Alt = tự động dò mặt phẳng 

Line = Đoạn thẳng 
Shift = khóa hướng 

VCB: nhập khoảng cách   

Scale = Thu phóng 
Shift = nghịch đảo đồng dạng 
Ctrl = hướng tâm 
VCB: tỉ lệ, độ dài mới (mm) 

Circle = Hình tròn 
VCB: số đoạn (s), bán kính (r) 

  

Offset = Sao chép đồng dạng 
Click đúp = dùng lại trị số cuối 
VCB: khoảng cách đồng dạng 

Arc = Cung tròn 
VCB: số đoạn, bán kính (r), 

đoạn dây cung (length), đoạn 
trung trực dây cung (bulge)   

Orbit = Xoay – nhìn 
Ctrl = bỏ khóa trục Z 
Shift = di chuyển  

Polygon = Đa giác 
VCB: số đoạn (s), bán kính 

ngoại tiếp (r)   
Pan = Dời – nhìn 

Free Hand = Phác tay 
Shift = đa tuyến 3 chiều 

  

Zoom = Thu phóng – nhìn 
Shift = thay đổi trường nhìn 
VCB: tiêu cự (mm), góc nhìn 
(deg) 

Tape Measure = Đo dài 
Ctrl = chỉ đo 

VCB: thay đổi tỉ lệ toàn cục   
Zoom Window = Cửa sổ 

Dimension = Ghi kích thước 
  

Zoom Extents = Phóng khít 

Text = Ghi chú 
  

Zoom Previous = Hồi lại 

Protractor = Đo góc 
Shift = chỉ đo 

VCB: góc, độ dốc   

Walk = Bộ hành 
Shift = di chuyển phương đứng 
Ctrl = chạy nhanh 
Alt = đi xuyên vật cản 
VCB: cao độ điểm nhìn 

Section = Mặt cắt 
  

Look Around = Nhìn quanh 
VCB: cao độ điểm nhìn 

Axes = Hệ trục tọa độ Position Camera = Định vị 
điểm nhìn 

Section Plane Toolbar  
Hiện mặt phẳng cắt / Hiện nét cắt 

Layer Toolbar  
Truy nhập layer / Hộp thoại layer 

Sandbox Tools 
Công cụ tạo địa hình 
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2. Dialogs Boxes (Hộp thoại) 

Khi làm việc với SketchUp hay bất kì phần mềm đồ họa nào, bạn 
luôn phải trao đổi với máy tính 2 vấn đề: 

• Tôi muốn máy tính làm gì? Ứng với việc thao tác lệnh. 

• Máy tính làm điều đó như thế nào? Ứng với việc cung cấp 
tham số lệnh hoặc tham số môi trường. 

Nếu Toolbars là nơi cung cấp thao 
tác lệnh thì tham số lệnh và tham số 
môi trường có thể tìm thấy trong 
Dialog Boxes (các hộp thoại). 

 Chỉ 9/14 hộp thoại là có thể kết 
thành bè trôi nổi tự do như hình bên, 
5 hộp thoại còn lại luôn đứng độc 
lập. 

Để tắt – bật từng hộp thoại vào menu 
Windows>Tên hộp thoại. Để cuốn – 
thả từng hộp thoại, click thanh tiêu đề hộp thoại. Để kết một 
hộp thoại vào bè, click rê thanh tiêu đề hộp thoại tới gần nhau, 
chúng sẽ tự bắt dính. Để tắt - bật cùng lúc tất cả các hộp thoại 
vào menu Windows/Show-Hide Dialogs. Di chuyển thanh tiêu 
đề của hộp thoại trên cùng sẽ di chuyển cả bè hộp thoại. 

3. Context Menu (Menu động) 
Nội dung menu động thay đổi tùy theo bối cảnh. Kích hoạt menu 
động bằng cách click phải chuột. Menu động có hiệu lực : 

• Khi chọn trước đối tượng 

• Khi hiện hành trong một số 
hộp thoại (Material Browser, 
Components …) 

• Trong giao diện SketchUp 
(trang màn hình, hệ trục). 

4. Value Control Box - 
VCB (Hộp nhập trị số) 
VCB nằm góc dưới bên phải màn hình. Nó hiển thị trị số hiện 
hành và cũng là nơi bạn nhập trị số khi thao tác lệnh. Đặc tính: 

• Enter để xác nhận trị số. Sau 
khi xác nhận vẫn có thể thay 
đổi trị số miễn là bạn chưa kích hoạt công cụ khác.Không 
cần thiết click vào VCB khi nhập trị, VCB luôn chờ tín hiệu 
phím số từ bàn phím. 

• Trị số lẻ (gần đúng) sẽ hiển thị kèm dấu “~” phía trước. 
Đôi khi trị số phải có đơn vị chính xác đi kèm. Đơn vị có 
thể cùng hoặc khác với đơn vị hệ thống hiện hành. 

• Nhập tọa độ tuyệt đối [x,y,z] hoặc tương đối <x,y,z>. Dấu 
“,” hay “;” ngăn cách tùy thiết lập của hệ điều hành.  

• Không nhập trị số trước dấu ngăn cách hàm ý lấy lại trị số 
cũ trước đó. 
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 1. Drawing Tools (Công cụ Vẽ) 
 Line Tool (Đoạn thẳng) 

Kích hoạt công cụ > click chọn điểm đầu đoạn > kéo chuột định 
độ dài và hướng > click chọn điểm cuối đoạn. 

 Có thể nhập trị số trong VCB thay cho việc kéo chuột. Có 
thể nhập tọa độ tương đối trong không gian của điểm tiếp theo 
dạng [x,y,x] hoặc <x;y;z> (tùy thiết lập trong hệ điều hành). 

Tạo mặt phẳng bằng 
cách vẽ 3 hay nhiều hơn 
3 đoạn thẳng đồng 
phẳng khép kín. Có thể 
hàn mặt phẳng khuyết 
cạnh bằng cách vẽ bổ sung cạnh bị khuyết.  

Chia đoạn thẳng bằng cách vẽ thêm đoạn thẳng khác có ít nhất 
một điểm On Edge trên đoạn cần chia.  

Để chia đều đoạn thẳng click phải lên đoạn > chọn Divide > 
nhập số đoạn bằng nhau cần chia. 

Chia mặt phẳng bằng cách vẽ đoạn thẳng có điểm đầu điểm 
cuối  thuộc chu vi mặt phẳng 

 Đoạn thẳng phủ qua chu vi 2 mặt phẳng (overlapping lines) 
không có tác dụng chia mặt. 

 

 Arc Tool (Cung tròn) 

Kích hoạt công cụ > nhập độ 
trơn đường cong nếu muốn 
(mặc định là 12) > click chọn 
điểm đầu cung > kéo và click 
chọn điểm cuối cung > kéo và click đoạn trung trực dây cung. 

  Các trị số đặc trưng cho một cung đều có thể nhập trong 
VCB thay cho việc kéo chuột. 

 Khi thao tác cung tròn qua trạng thái nửa đường tròn 
SketchUp sẽ hiện điểm và thông báo qua Tooltip. 

Khi vẽ nhiều đoạn cung nối tiếp, đoạn cung nào đang vẽ bật 
sáng xanh lơ là đoạn cung tiếp tuyến với đoạn cung trước nó. 

Thêm kí tự “r” sau trị số nhập trong VCB để xác định bán kính 
cung tròn thay cho chiều dài đoạn trung trực dây cung. Thêm kí 
tự “s” sau trị số để thay đổi độ trơn của cung 

II. VEÕ CAÊN BAÛN 
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Freehand Tool (Phác tay) 

Kích hoạt công cụ > click chọn điểm bắt đầu > nhấn giữ phím trái 
chuột trong khi kéo > thả phím 
trái chuột ở điểm kết thúc. 
Đường tạo ra có thể khép kín 
hoặc không.  

 Để vẽ 3D Polyline giữ 
phím Shift trong khi thao tác. 
3D Polyline là đối tượng phi  
hình học trong môi trường SketchUp, không thể truy bắt, dùng 
để đồ lại nét ảnh nền nhập vào. 

 Click phải đường 3D Polyline > chọn Explode để phá 3D 
polyline thành đa tuyến hình học, có thể truy bắt. 

 

 Rectangle Tool (Hình chữ nhật) 

Dùng tạo ra một mặt phẳng có chu vi hình chữ nhật hoặc vuông. 
Cạnh của hình luôn song song với hệ trục tọa độ hiện hành. 

Kích hoạt công cụ > click chọn góc đầu > di chuyển chuột và 
click chọn góc đối diện. 

 Có thể nhập trị số dài và rộng trong VCB. Xoay hệ trục nếu 
muốn vẽ hình chữ nhật khác hướng hệ trục hiện hành. 

Khi thao tác hình chữ nhật qua  trạng thái hình vuông hoặc 
hình có tỉ lệ vàng SketchUp sẽ báo hiệu bằng đường chéo nét 
đứt và Tooltip. 

 Circle Tool (Hình tròn) 

Tạo mặt phẳng có chu vi hình tròn, thuộc một mặt phẳng hiện 
hữu hoặc mặt phẳng hệ trục hiện hành. 

Kích hoạt công cụ > click chọn tâm > kéo chuột định bán kính và 
click hoàn tất. 

 Các trị số đặc trưng cho hình tròn đều có thể nhập trong 
VCB thay cho việc kéo chuột. Thêm kí tự “s” sau trị số để thay 
đổi độ trơn đường tròn. 



Hướng dẫn sử dụng SketchUp 5.0 Chương II – Vẽ căn bản   Trang 3 

 

 Polygon Tool (Hình đa giác) 

Dùng vẽ đa giác thường nội tiếp hình tròn từ 3 đến 100 cạnh 
thuộc mặt phẳng hiện hữu hoặc mặt phẳng hệ trục hiện hành. 

Kích hoạt công cụ > chọn số cạnh đa giác > click chọn tâm > kéo 
chuột định bán kính đường tròn nội tiếp > click hoàn tất. 

 Các trị số đặc trưng cho đa giác đều có thể nhập trong VCB 
thay cho việc kéo chuột hoặc sau khi vẽ 

 

2. Principle Tool (Công cụ Thiết yếu) 
 

 Select Tool (Chọn đối tượng) 

 
Thao tác chuột Hiệu quả 

Click đơn Chọn đối tượng đơn 

Rê từ phải sang trái Chọn đối tượng nằm trong và 
giao cắt với vùng chọn 

Rê từ trái sang phải Chọn đối tượng nằm trong vùng 
chọn 

Ctrl + Click đơn Thêm đối tượng vào tập chọn 

Ctrl + Shift + Click đơn Loại đối tượng khỏi tập chọn 

Shift + Click đơn Nghịch đảo trạng thái được chọn 
– không được chọn 

Click đúp cạnh Chọn cạnh và mặt nối với nó 

Click đúp mặt Chọn mặt và cạnh bao 

Click 3 lần liên tiếp Chọn tất cả các mặt và cạnh nối 
liền với đối tượng 

Ctrl+A Chọn toàn bộ mô hình 

Ctrl+T hoặc click vùng trắng Hủy chọn toàn bộ 

 Dùng menu động để có thêm các tùy chọn 

Bounding Edges - Chọn cạnh bao 
Connected Faces – Chọn mặt nối liền 
All Connected – Chọn tất cả các phần nối liền 
All on same layer – Chọn tất cả đối tượng cùng Layer 
All with same material – Chọn tất cả đối tượng cùng vật liệu 

 

 Paint Bucket Tool (Tô đối tượng) 

Dùng để tô màu sắc hoặc vật liệu cho đối tượng. 

Kích hoạt công cụ > Chọn màu hoặc vật liệu trong Material 
Browser được kích hoạt cùng lúc với công cụ > Click một đối 
tượng hoặc một tập hợp chọn. 

 Cần chuyển chế độ hiển thị Shaded hoặc Shaded with 
Texture để có thể nhìn thấy những gì bạn tô. 



Hướng dẫn sử dụng SketchUp 5.0 Chương II – Vẽ căn bản   Trang 4 

 Qui ước khi tô 

• Khi tô mặt trước hoặc sau một mặt phẳng nằm trong tập 
hợp các mặt phẳng được chọn, các mặt phẳng còn lại sẽ 
được tô mặt trước hoặc sau tương ứng. 

• Có thể áp lệnh tô lên một hay nhiều cạnh. Để có thể thấy 
hiệu quả này cần chọn chế độ hiển thị Windows > Display 
Settings > Edge color > By Material. 

• Kết hợp phím Ctrl để tô tất cả những mặt liên kết và có 
cùng vật liệu ban đầu với mặt đang tô. 

• Kết hợp phím Shift để chuyển đổi tất cả các mặt có cùng 
loại vật liệu sang vật liệu mới đang tô. 

• Kết hợp phím Ctrl + Shift để chuyển đổi tất cả các mặt có 
cùng loại chất liệu và có liên kết với nhau sang vật liệu 
mới đang tô 

• Kết hợp phím Alt  để lấy mẫu vật liệu  từ đối tượng nào đó 
trong mô hình thành vật liệu hiện hành 

• Khi áp vật liệu lên Group hoặc Component, những mặt 
phẳng đã áp vật liệu khác trước đó sẽ không bị ảnh 
hưởng bởi vật liệu mới. 

3. Camera Tool (Công cụ Quan sát) 
Không gian vẽ có thể chuyển đổi giữa phép chiếu phối cảnh 
(Perspective) hoặc hình chiếu trục đo (Paraline) trong menu 
Camera > Perspective.  

Kết hợp với các mặt phẳng chiếu cơ bản sẽ tạo được hầu hết 
các hình chiếu mong muốn 

Truy cập nhanh các công cụ theo bảng 

Thao tác Hiệu quả 

Lăn lên nút giữa chuột Phóng to khung nhìn 

Lăn xuống nút giữa chuột Thu nhỏ khung nhìn 

Ctrl+Shift+E Phóng toàn bộ khít màn hình 

Ctrl+Shift+W (tự đặt) Phóng một phần khít màn hình 

Shift+Rê nút giữa chuột Trượt khung nhìn 

Rê nút giữa chuột Xoay khung nhìn giới hạn trục Z 

Ctrl+Rê nút giữa chuột Xoay tự do khung nhìn 

 

 Khi dựng hình nên chọn phép chiếu trục đo. 

 Những tính năng nâng cao liên quan đến camera, chế độ 
hiển thị trong mô hình có thể xem chương V. 
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4. Modification Tools (Công cụ Hiệu chỉnh) 
 

 Move Tool (Di chuyển đối tượng) 

Chọn một hoặc nhiều đối tượng > Kích hoạt công cụ > Click 
chọn điểm đầu > Click chọn điểm đến. 

Để di chuyển một cách chính xác nên kết hợp với truy bắt điểm 
khóa hướng và nhập liệu trong VCB. 

 Có thể dùng công cụ Move di 
chuyển một phần đối tượng để thực hiện 
lệnh Schetch (co dãn đối dượng).  

Lệnh Sketch tùy theo bối cảnh sẽ tạo ra 
nếp gấp (Moving/Schetching with 
Autofold) hoặc không tạo ra nếp gấp. 

Xu hướng chung của SketchUp là hạn chế tối đa việc phát sinh 
các nếp gấp và mặt  phẳng khi Schetch bằng cách khóa các 
hướng di chuyển gây ra biến dạng quá lớn. Để bỏ qua tính năng 

này, giữ phím Alt trong khi Schetch, ta sẽ có tính năng biến 
dạng cưỡng bức (Forcing Autofold). 

 Sao chép đối tượng (Copy) bằng cách giữ phím Ctrl sau 
khi kích hoạt công cụ và trước khi chọn điểm đầu. 

Tạo dãy tuyến tính với khoảng cách chỉ định (Linear Array) 
bằng cách gõ từ khóa nx hoặc *n. Với n là số đối tượng của dãy. 

Tạo dãy tuyến tính chia 
quãng đều giữa 2 điểm cho 
trước bằng cách gõ từ khóa 
n/ hoặc /n. Với n là số đối 
tượng của dãy. Tính năng này 
rất hữu ích khi tạo hàng rào, cầu hoặc bố trí bàn ghế …  

 

 Rotate Tool (Xoay đối tượng) 

Chọn một hoặc nhiều đối tượng > 
Kích hoạt công cụ > Click chọn tâm 
quay > Click chọn điểm đầu góc quay 
> Click chọn điểm cuối góc quay. 

Để xoay một cách chính xác nên kết 
hợp với truy bắt điểm khóa hướng và 
nhập liệu trong VCB.  

Công cụ xoay có thể tạo ra hiệu ứng Vặn (Twist) hoặc Gấp 
(Fold) nếu tác động lên một phần của đối đượng. 
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 Có thể dùng công cụ Rotate để Sao chép đối tượng 
(Copy) bằng cách giữ phím Ctrl sau khi kích hoạt công cụ và 
trước khi chọn điểm đầu góc xoay. 

Tạo dãy hướng tâm với góc chỉ định (Radial Array) bằng 
cách gõ từ khóa nx hoặc *n. Với n là số đối tượng của dãy. 

Tạo dãy hướng tâm chia góc đều trong góc cho trước bằng 
cách gõ từ khóa n/ hoặc /n. Với n là số đối tượng của dãy.  

Đôi khi việc xác định mặt phẳng, tâm và trục quay gặp khó 
khăn, đòi hỏi phải dời trục – dựng mặt phụ. Thay vì thế, có thể 
dùng tính năng chọn trục quay và mặt phẳng quay bằng cách 
Click-giữ nguyên nút trái chuột khi thao tác chọn tâm quay. 

 

 Scale Tool (Thu phóng đối tượng) 

Chọn đối tượng > Kích hoạt công cụ > Click chọn grip (tay nắm) 
cần tác động >Thao tác chuột, phím hoặc VCB.  

Mỗi khi chọn một grip, grip tương ứng đối diện được điểm sáng 
và trở thành điểm neo của phép thu phóng, loại grip khác nhau 
có tính năng khác nhau 

 

Grips (Tay nắm) Hiệu quả 

Coner grip – Góc Thu phóng theo hệ số tỉ lệ chung 3 phương 

Edge grip – Cạnh Thu phóng theo hệ số tỉ lệ riêng 2 phương 

Face grip – Mặt Thu phóng theo hệ số tỉ lệ 1 phương  

Thao tác khác nhau cũng mang lại hiệu quả khác nhau 

Thao tác Hiệu quả 

Kéo chuột Thử tỉ lệ tùy ý cho đến khi click 
chuột xác nhận 

Giữ phím Ctrl + Kéo chuột Thu phóng với điểm neo là tâm 
của tập chọn 

Giữ phím Shift + Kéo chuột Đảo ngược tính năng thu phóng 
theo hệ số tỉ lệ chung hoặc riêng 

 Tất cả các hệ số tỉ lệ có thể nhập chính xác trong VCB thay 
cho việc kéo chuột. 

 Tính năng thay đổi trị số sau khi 
Enter rất hữu ích khi Scale hướng tâm 
có tỉ lệ. Không thể cùng lúc nhấn Ctrl 
và chữ số, hãy scale hướng tâm với hệ 
số tỉ lệ bất kì sau đó nhập lại tỉ lệ đúng. 
Tương tự cho việc dò tìm hệ số tỉ lệ 
ưng ý nhất. 

Nhập trị số kèm theo đơn vị trong VCB tương ứng việc thu 
phóng theo tham số khoảng cách giữa 2 grips. 
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 Việc thu phóng chỉ tác động lên kích thước đường bao tập 
chọn (Bounding Box). Do chúng ta thường chọn duy nhất 

một đối tượng và đường bao thường hay trùng khớp với chu vi 
đối tượng nên rất dễ quên điều này.  

 Một số trường hợp bắt buộc dời trục để scale chính xác 

 

 Push/Pull Tool (Kéo/Nén đối tượng) 

Kích hoạt công cụ > Click chọn mặt phẳng > Kéo rồi click chuột 
hoặc nhập trong VCB khoảng cách kéo/nén. 

 Copy mặt nền mới (starting face) bằng cách giữ phím Ctrl 
sau khi kích hoạt và trước khi chọn mặt. 

Click đúp khi chọn mặt để tự động 
áp trị số kéo/nén trước đó. 

Có thể dùng công cụ Push/Pull 
đục khoảng thông một khối khi 
nén mặt phẳng thành phần xuống 
hết chiều cao khối. 

 

 Follow Me Tool (Trượt dẫn đối tượng) 

Kích hoạt công cụ > Click chọn tiết diện > Kéo chuột dọc theo 
đường dẫn > Click chuột tại vị trí kết thúc. 

Để trượt dẫn chính xác hơn nên : Chọn đường dẫn > Kích hoạt 
công cụ > Chọn tiết diện. 

 Tiết diện phải tương đối vuông 
góc với đường dẫn. 

Giữ phím Alt khi chọn tiết diện 
để kích hoạt chế độ tự động dò 
đường dẫn và trượt dẫn khép kín. 

Chọn mặt phẳng > Kích hoạt công 
cụ > Chọn tiết diện tạo sẽ ra hiệu 
ứng tiết diện tự động trượt dẫn khép 
kín theo chu vi mặt phẳng. 

Trượt dẫn một tiết diện theo đường dẫn hình tròn có tâm nằm 
trên trục đối xứng của tiết diện sẽ tạo ra khối tròn xoay. 

 

 Offset Tool (Sao chép đồng dạng) 

Chọn một mặt phẳng, hai hay 
nhiều đoạn thẳng đồng 
phẳng > Kích hoạt công cụ > 
Click chuột lên tập hợp đã 
chọn > Kéo chuột định miền 
và khoảng cách sao chép > Nhập trị số trong VCB hoặc click 
chuột xác nhận.  

Click đúp lên tập hợp chọn khi thao tác lệnh Offset để lập lại 
miền và khoảng cách sao chép trước đó. 
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Intersect with Model (Giao cắt khối) 

Dùng để lấy giao tuyến và mặt tạo bởi các hình khối giao nhau. 

Xếp các hình khối về trạng thái giao cắt > Quét chọn > Click phải 
hiện menu động > Chọn Intersect with Model > Xóa phần thừa. 

 Nếu thành phần giao cắt là Group hoặc Component, giao 
tuyến và mặt tạo thành sẽ nằm trong cùng bối cảnh tương ứng.  
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Ngoài tính năng hiển thị - nhập số trong VCB đã đề cập, để có 
thể vẽ chính xác cần nắm vững các tính năng sau 

1. Inference (Nội suy) 

Chế độ bắt điểm luôn thường trú mà không có tùy chọn nào 
khác, giúp bạn nhận biết và truy bắt các điểm đặc biệt. Khi bắt 
điểm, các tooltip bật tên theo bảng bên dưới, điểm đặc biệt bật 
sáng theo chỉ thị màu. 

Chế độ dò vết giúp xác định một điểm bất kì nằm trên 1 vết đặc 
biệt. Vết đặc biệt có nét liền và màu như bảng bên dưới 

Chế độ dò điểm giúp xác định 1 điểm bất kì nằm trên 1 vết đặc 
biệt đi qua 1 điểm đặc biệt hiện hữu. Chế độ này có tooltip “From 
point” kèm theo vết đặc biệt nhưng thể hiện bằng nét đứt. 

Hình dưới minh họa cho khả năng dò điểm và dò đường trong 
SketchUp 

 Tên điểm Màu Mô tả 
Endpoint Xanh lục Điểm đầu – cuối đoạn hay cung 
Midpoint Xanh lơ Điểm giữa đoạn hoặc cạnh
Intersection Đen Giao đoạn - đoạn hay đoạn – mặt
On Face Xanh đen Điểm thuộc mặt
On Edge Đỏ Điểm thuộc cạnh
Equi-Dist on Edge Điểm đỏ, vết tím Điểm vạt góc đều
Half Circle - Tạo đường tròn khi vẽ cung
Center Xanh lục Điểm tâm hình tròn

Tên vết Màu vết Mô tả 
On Axis Đỏ Vết song song hoặc trên trục X 
On Axis Xanh lục Vết song song hoặc trên trục Y 
On Axis Xanh đen Vết song song hoặc trên trục Z 
Parallel to Edge Tím Vết song song với đoạn  
Perdendicular to 
Edge 

Điểm đỏ, vết tím Vết vuông góc với đoạn 

From Point 
Màu như trên –
vết có nét đứt 

Dò điểm 

III. VEÕ NAÂNG CAO 
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 Khi thao tác chuột trên một mặt hiện hữu, chương trình tự 
động vẽ trên mặt đó. Nếu không có mặt hiện hữu, không có chỉ 
định bắt điểm nào khác, chương trình tự động vẽ trên mặt tạo 
bởi hệ trục và mặt hình chiếu thời điểm đó. 

Mọi chế độ nội suy đều bảo toàn dù các đối tượng hình học nằm 
trong Group hoặc Component. 

2. Inference Locking (Khóa hướng) 
Trong một không gian vẽ quá hẹp, dị chuyển chuột dễ dàng gây 
nhiễu khi nội suy. Cách tốt nhất là khóa hướng. Hình bên cho 
thấy cách khóa hướng để dò được vết song song trục Z như ý 

muốn mà không lẫn lộn sang 
trục khác hoặc điểm khác. 

Để khóa hướng chỉ cần giữ 
phím Shift ngay sau khi nhá 
chọn được vết mong muốn. 
Vết sẽ nổi đậm lên. Lúc này 
bất kể chuột ở đâu, chương 
trình chỉ hiểu 1 vết duy nhất. 

3. Drawing Axes (Hệ trục 
tọa độ) 
Gồm 3 đường thẳng với 3 màu Đỏ - Lục 
– Xanh ứng với trục X – Y – Z vuông 
góc với nhau. Origin là điểm gốc hệ trục 
khi vừa khởi tạo 1 mô hình. Hệ trục giúp 
bạn định vị trong không gian 3D, dò vết 

và vẽ chính xác. Có thể tương tác với hệ trục thông qua menu 
động bằng cách click phải lên thành phần bất kì của hệ trục. 

Dời và xoay tùy ý chọn Place > click chọn gốc tọa độ mới > 
click chọn hướng trục X > click chọn hướng trục Y. 

Dời và xoay chính 
xác chọn Move > 
hộp thoại Move 
Sketching Context > 
nhập khoảng cách 
trục mới so với trục 
cũ, SketchUp tự 
động hiểu đơn vị mặc định của hệ thống (hình trên). 

Khôi phục hệ trục gốc chọn Reset 

Tắt hiển thị hệ trục chọn Hide 

Khi xuất file, hệ trục tự động tắt. 
Việc dời trục rất cần thiết khi cần vẽ, 
hiệu chỉnh các đối tượng, mặt 
phẳng, đoạn thẳng không song 
song với hệ trục. 

Kết hợp các tính năng trên với 
các lệnh vẽ cơ bản đã trình bày ở chương I cũng như các tín 
năng từ phần này trở về sau, bạn sẽ mở rộng sự linh hoạt và 
chính xác một cách đáng kể. Các tính năng này có giá trị xuyên 
suốt SketchUp. Đừng quên áp dụng chúng bất cứ lúc nào có thể. 
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4. Construction Tools (Công cụ Xây dựng) 
Tính khả thi được hiểu là mức độ chi tiết của thông tin mà bạn 
cung cấp cho cho chương trình khác, cho người khác hoặc cho 
quá trình tái tạo lại mô hình ngoài đời thực. 

 Tape Measure (Đo dài) 

Kích hoạt công cụ > click chọn điểm đầu > click chọn điểm cuối. 

• Nếu cả 2 điểm là Enpoint: đo dài thuần túy, đọc trị số 
trong VCB 

• Nếu chỉ có 1 điểm là 
Endpoint: đo dài kết hợp tạo 
đoạn dóng (thể hiện nét 
đứt). Điểm cuối của đoạn 
dóng được đánh dấu và có 
thể truy bắt. Điểm dóng này gọi là Construction Point 

• Chỉ click 1 điểm On Edge và 
kéo chuột ra ngoài: tạo một 
đường trục song song với 
đoạn, khoảng cách song 
song có thể nhập trong 
VCB. Đường trục này gọi là 
Construction Line.  

Trong mọi trường hợp, giữ phím Ctrl trong lúc thao tác để đo 
dài thuần túy. 

Một tính năng quan trọng khác của Tape Measure là Thu phóng 
toàn cục mô hình. Thao tác như sau 

• Xác định đoạn thẳng dự định làm cơ sở thu phóng toàn 
mô hình. Dùng Tape Measure đo độ dài thuần túy của 
đoạn, quan sát trị số trong VCB. 

• Nhập độ dài mới. Tỉ lệ độ dài mới / cũ sẽ là tỉ lệ thu phóng 
tất cả các độ dài khác trong mô hình. 

 Thu phóng toàn cục chỉ có tác dụng với component tạo mới 
trong mô hình hiện hành. Component trong thư viện, component 
là bản vẽ tham chiếu không bị ảnh hưởng của thao tác này. 

 Protractor (Đo góc) 

Kích hoạt công cụ > Click chọn vị trí 
tâm thước góc > Click chọn hướng 
đường 00 > tùy chọn như sau 

• Để đo góc thuần túy > Click 
chọn hướng còn lại. Trị số góc 
sẽ hiển thị trong VCB. Đồng 
thời một đường trục (Construction Line) được tạo ra trên 
hướng click sau cùng 

• Để dựng góc > nhập góc hoặc độ dốc x : y trong VCB. 

  Thước góc tự động bắt dính theo nấc 150, tự động bắt dính 
vào mặt phẳng gần nhất. Góc âm xuôi chiều kim đồng hồ, góc lẻ 
thể hiện dạng thập phân. Có thể khóa hướng để định vị tâm 
thước góc chính xác hơn . 
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 Dimension Tool (Ghi kích thước) 

Ghi kích thước thẳng: kích hoạt công cụ > chọn điểm đầu cho 
đường dóng > chọn điểm tiếp theo cho đường dóng > kéo chuột 
chọn phương của đường kích thước. 

Có thể ghi kích thước đoạn nhanh bằng cách kích hoạt công 
cụ > click điểm On Edge trên đoạn > kéo chuột chọn phương 
của đường kích thước. 

Ghi kích thước đường kính - bán kính: kích hoạt đối tượng > 
click chọn cung tròn (Arc) hoặc hình tròn (Circle) > kéo chuột 
chọn phương của đường kích thước.  

Chuyển đổi kích thước bán kính 
sang đường kính hoặc ngược lại 
bằng cách: click phải đường kích 
thước > chọn Type > chọn 
Radius hoặc Diameter. 

Khi bạn quay – dời đối tượng 
đã ghi kích thước, đường kích 
thước sẽ quay – dời chuyển theo. 
Có thể chỉnh sửa số kích thước thông qua menu động. 

 Chữ số kích thước nằm trên phương đứng hoặc nằm trên 
đường kích thước tùy theo thiết lập toàn cục trong hộp thoại 
Model Info, xin xem các chương sau. 

 Text Tool (Ghi chú) 

Ghi chú thuần túy: Kích hoạt công cụ > click vào khoảng trắng 
màn hình  > nhập chữ. Ghi chú đối tượng: Kích hoạt công cụ > 
click chọn điểm đầu mũi tên trỏ vào > click chọn phương dòng 
chữ > nhập chữ. 

Mũi tên trỏ có 2 loại: luôn 
hướng theo màn hình (View Based) và luôn hướng theo không 
gian vật thể (Pushpin), thiết lập trong hộp thoại Model Info. 

Khi ghi chú đồi tượng, nếu không thay đổi, mặc định dòng 
Text thể hiện các thông số tùy theo loại đối tượng (độ dài, diện 
tích, dài x rộng x cao … ) 

Click đúp lên mặt phẳng bất kì khi đang thao tác Text Tool để lấy 
con số diện tích dạng text, rất hữu ích khi ghi chú nhanh diện 
tích phòng. 

Khác với chữ số kích thước có tính toàn cục. Các chữ ghi chú 
trong một mô hình có thể mang các thuộc tính khác nhau. 
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 Section Plane (Mặt phẳng cắt) 

Công cụ này tạo ra mặt phẳng cắt (section plane) và vết cắt 
(section slice). Thao tác: kích hoạt công cụ rồi > chọn phương 
hướng cắt thích hợp. 

Khi kích hoạt, mặt phẳng cắt tự động bắt dính mặt phẳng và hệ 
trục gần nhất. Vì vậy nên tận dụng tính năng khóa hướng để có 
kết quả chính xác. 

Có thể dùng công cụ hiệu chỉnh Move hoặc Rotate để dời – 
xoay mặt phẳng cắt. 

 Không thể giới hạn một mặt phẳng cắt trong cùng một bối 
cảnh (context). Một mặt phẳng cắt luôn cắt qua tất cả các đối 
tượng giao với mặt phẳng đó trong cùng một bối cảnh (context). 

Tạo một group các đối tượng cần cắt > chuyển đến bối cảnh 
group đó > tạo section plane trong bối cảnh > chuyển về bối 
cảnh mô hình. Bằng cách đó ta đã giả lập việc giới hạn mặt 
phẳng cắt, chỉ cho nó cắt qua một số đối tượng nhất định. 

Tương tác với mặt phẳng cắt bằng cách click phải lên mặt 
phẳng cắt > menu động. Có các tùy chọn: 

• Đảo hướng cắt chọn Reverse 

• Nếu có nhiều hơn một mặt phẳng cắt chọn Active Cut để 
kích hoạt mặt phẳng cắt tương ứng. 

• Giao tuyến màu đỏ trên màn hình là vết cắt ảo chỉ có giá 
trị hiển thị. Để tạo vết cắt thật chọn Create Group from 

Slice. Thao tác này tạo ra vết cắt đa tuyến, độc lập với 
đồi tượng bị cắt, có bối cảnh riêng và thuộc tính riêng. 

• Chọn Align View để dóng mặt phẳng chiếu theo mặt 
phẳng cắt. Rất hữu ích khi cần tạo mặt cắt 2D hoặc mặt 
cắt phối cảnh 1 điểm tụ. 

• Chọn Hide để tắt hiển thị mặt phẳng cắt. 

 Tại một thời điểm, trong một bối cảnh (context) chỉ có một 
mặt phẳng cắt duy nhất có thể hiện hành và cho hiệu ứng cắt. 

Nếu muốn có nhiều hiệu ứng cắt trong cùng một thời điểm, 
cần tạo ra nhiều bối cảnh, mỗi bối cảnh chứa một section plane. 
Thủ thuật này cũng được dùng khi cần tạo mặt cắt không đồng 
phẳng (gập đoạn) 

Hiệu ứng cắt có thể xuất ra file ảnh điểm hoặc ảnh vectơ. Chỉ có 
vết cắt thật (section slice) mới xuất ra ảnh vectơ được. 

Sử dụng Pages (trang màn hình) để lưu giữ hiển thị của hiệu 
ứng cắt. Hiệu ứng cắt có thể tham gia vào hoạt cảnh. 
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5. Sandbox Tools (Công cụ Tạo địa hình) 
Điểm cải tiến đáng kể nhất của phiên bản 5.0 so với trưóc đó. 
Nhóm công cụ nâng cao này mặc định ẩn sau khi cài đặt 
SketchUp. Để có thể sử dụng cần bật nó lên qua menu Window 
> Preferences > Extension > check vào mục Sandbox Tools. 

 Sandbox from Contours (Tạo từ đường đồng 
mức). 

Trước hết cần có các đường đồng mức như hình trên. Có thể 
tạo đường đồng mức bằng các công cụ vẽ trong SketchUp hoặc 
nhập đường đồng mức từ phần mềm khác vào SketchUp. 

Thao tác: vào menu Draw > Sandbox > From Contour. Mặt địa 
hình sẽ tự động tạo ra dựa trên cơ sở các đường đồng mức. 

 Đôi khi do độ dốc quá ít, công cụ tạo lại tạo ra một mặt dốc 
không như ý. Hãy dùng chức năng Flip Edge (lật cạnh tam giác 
đơn vị) để khắc phục tình trạng đó. 

 

Sandbox from Scratch (Tạo từ mặt TIN phẳng) 

Kích hoạt công cụ > clich chọn điểm đầu lưới TIN phẳng > kéo 
rồi click chuột định chiều dài lưới (trị sồ trong VCB) > kéo rồi 
click chuột định chiều rộng lưới (trị số trong VCB). 

Khoảng cách đơn vị lưới (Grid Spacing)mặc định là 10 đơn 
vị. bạn có thể thay đổi trị số này trong VCB trưóc khi vẽ lưới. 
Chiều dài – rộng của lưới cũng có thể nhập trong VCB khi vẽ. 

 Sau khi tạo lưới, đối tượng lưới sẽ là một group, nếu muốn 
hiệu chỉnh cần phải vào bối cảnh tương ứng hoặc phá vỡ group. 

 Smoove Tool (Tạc bề mặt địa hình) 

Kích hoạt công cụ > xác định bán kính ảnh hưởng đỉnh (thông 
qua VCB) > click chọn ví trí địa hình cần tạc > di chuyển chuột 
tạo cao độ mong muốn > làm mềm mặt địa hình để có hiệu quả 
cuối cùng. 
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 Đảm bảo đã rã group mặt TIN địa hình hoặc đã vào bối 
cảnh tương ứng trước khi thao tác lệnh này. 

Có thể chọn một nhóm đỉnh – cạnh trên mặt TIN trước khi 
kích hoạt công cụ Smoove. Thủ thuật này rất hữu ích khi vẽ 
đường phân thủy - hợp thủy trên địa hình. 

Click đúp khi đang thao tác để lấy lại phạm vi chọn và cao 
độ lần vị trí trước đó áp dụng cho vị trí mới. 

Tuy mặc định công cụ Smoove di chuyển các đỉnh TIN theo 
phương đứng để đảm bảo các địa hình tồn tại phù hợp nguyên lí 
trượt đất. Nhưng vẫn có thể ép các đỉnh di chuyển theo phương 
khác nếu giữ phím Shift khi thao tác. 

 Cần cân nhắc việc ép đỉnh TIN di chuyển theo phương khác 
phương đứng. Việc này có thể vô tình tạo ra mặt địa hình không 
dùng được trong san nền (hàm ếch chẳng hạn) song cũng có thể 
tạo ra các mặt hữu cơ sinh động (mặt vải, chi tiết trang trí). 

Stamp Tool (San nền) 

Công cụ tạo một hay nhiều mặt nền phẳng để đặt khối kiến trúc 
lên trên bề mặt địa hình. Thao tác: 

• Tạo hoặc chọn mặt nền của khối mô hình. Định vị mặt 
nền lên phía trên mặt TIN, không nhất thiết phải tiếp xúc.  

• Kích hoạt Stamp Tool và click chọn mặt nền. Hộp VCB 
chờ nhập khoảng cách chân nền so với mặt nền . 

• Click lên mặt TIN địa hình. Di chuyển chuột để xác định 
cao độ mặt nền so với địa hình. Click chuột sau khi hoàn 
tất. Làm mềm mặt địa hình cho hiệu quả sau cùng 

Mặt nền khối mô hình có thể là một hay nhiều mặt phẳng, 
group hoặc component đều được. 

 Stamp Tool sẽ không có tác dụng trên group hoặc 
component đang mở để hiệu chỉnh. 
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 Drape Tool (Phủ mặt địa hình) 

Công cụ này chiếu một đối tượng (con đường chẳng hạn) thành 
những đoạn thẳng phủ trên bề mặt địa hình. Thao tác: 

• Tạo hoặc nhập mặt địa hình trong SketchUp 

• Tạo đối tượng phủ mặt địa hình (đường hoặc mặt phẳng). 
Đặt chúng nằm trên mặt địa hình (không nhất thiết tiếp 
xúc). 

• Chọn đối tượng phủ mặt địa hình. Kích hoạt Drape Tool 

• Chọn mặt TIN địa hình. Phần nét phủ mặt địa hình sẽ 
được tạo ra như hình dưới 

Dù đối tượng phủ mặt là mặt phẳng cũng chỉ có đường bao 
của nó được chiếu lên mặt địa hình. 

 Nếu mặt TIN đang trong một group hoặc component thì 
đường phủ mặt địa hình sẽ không nằm trong bối cảnh của group 
hoặc component đó. 

Nếu không chọn trước đối tượng phủ mặt vẫn có thể thao 
tác lệnh. Lúc đó SketchUp sẽ yêu cầu bạn chọn đối tượng phủ 
mặt địa hình trước khi chọn địa hình. 

 

 Add Detail Tool (Chi tiết hóa mặt TIN) 

Tạo mặt TIN từ lưới > kích hoạt công cụ > click chọn đỉnh, cạnh 
hoặc mặt tam giác đơn vị trên mặt TIN. 

Tính năng chi tiết hóa mặt TIN thường tập trung vào một vài 
trị trí cần độ mềm cao khi thao tác với công cụ Smoove. 

 Sử dụng những nơi thật cần thiết, tránh làm nặng thêm mô 
hình một cách không cần thiết. 
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Flip Edge Tool (Lật cạnh tam giác đơn vị của 
mặt TIN) 

Tái tạo mặt địa hình là việc tương đối phức tạp, trong vài trường 
hợp, SketchUp tạo ra những mặt dốc không như ý. Khi đó, cần 
dùng công cụ này để lật cạnh các mặt tam giác cơ sở lưới TIN 

Kích hoạt công cụ > di chuyển chuột trên mặt dốc để điểm sáng 
những cạnh tam giác có thể lật > click xác nhận cạnh lật. 

Không thể thấy được các tam giác đơn vị trên mặt địa hình 
đã làm mềm. Thay vì làm sắc nét trở lại, hãy vào menu View > 
Hidden Geometry. 

 Chỉ có những cạnh tam giác đơn vị có thể lật mới phát sáng 
khi rà chuột qua. Việc nhận biết này do SketchUp quyết định. 
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 1. Layer Manager (Quản lí lớp bản vẽ) 
Bật tắt hộp thoại qua menu Window/ Layers. Hoặc bật tắt nhóm 
công cụ qua menu View/Toolbar/Layers 

Thao tác với hộp thoại  

• Nút Add, Delete dùng Tạo, Xóa layer 

• Dấu option check dùng chuyển đổi layer hiện hành.  

• Click đơn vào cột Name để thiết lập, thay đổi  tên layer. 
Dùng check box tương ứng cột Visible để tắt bật layer. 
Click đơn vào màu tương ứng cột Color để chỉnh màu 
hiển thị của layer 

Click vào nút hình tam giác tô đen nằm ngang, góc trên bên phải 
hộp thoại để kích hoạt Details Menu với các tính năng: Select 
All (chọn tất cả các layer), Purge (xóa các layer rỗng), Color by 
Layer (màu hiển thị lấy theo màu layer thay vì màu đối tượng) 

Thao tác với nhóm công cụ 

• Chọn tên layer trong list box để chuyển layer hiện hành. 
Nếu trước đó đã chọn một hay nhiều đối tượng sẽ đồng 
thời gán các đối tượng đã chọn vào layer đó. 

 Có thể tắt nhưng không thể xóa layer0. Không thể tắt layer 
hiện hành. 

 
 

Đối tượng thuộc layer0 nhưng nằm trong group-component  
thuộc layer khác vẫn hiển thị  dù đã tắt layer0. 

Khi xóa một layer không rỗng, SketchUp cho 3 tuỳ chọn : Xóa 
triệt để _  Xóa layer nhưng chuyển nội dung layer về layer mặc 
định ( thường hiểu là layer0 )_ Xóa layer nhưng chuyển nội dung 
layer về layer hiện hành 

 Sự hiển thị hay không hiển thị của một đối tượng được xác 
định theo thứ tự ảnh hưởng giảm dần như sau 

• Thiết lập hiển thị của group_component chứa đối tượng. 

• Thiết lập hiển thị của bản thân đối tuợng 

• Thiết lập hiển thị của layer chứa group_component 

• Thiết lập hiển thị của layer chứa đối tượng 

 

  Hộp thoại Layer Manager và 
nhóm công cụ Layers. 

IV. VEÕ COÙ HEÄ THOÁNG 
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2. Component Browser (Quản lí Component) 
Bật tắt hộp thoại qua menu 
Window/Components. Thông 
qua hộp thoại, sử dụng các phím 
mũi tên, danh sách các library để 
tìm kiếm các component. 

Để chèn một component vào mô 
hình, đơn giản click hiện hành 
component trong hộp thoại 
browser sau đó click lên vùng vẽ. 

Để tạo một component: chọn các 
đối t  ượng cần tạo, click phải 
chọn Make Component. Sau đó 
đặt tên cho component. Tất cả các 
component dùng trong mô hình được hiển thị trong thư viện “In 
Model”. 

 Khi import 1 mô hình SketchUp khác vào mô hình hiện 
hành nó sẽ tạo thành 1 component tương ứng. 

Menu động khi click phải lên một component trong mô hình: 

• Entities Info hiển thị và hiệu chỉnh các thuộc tính như: 
tên, mô tả thành phần hình học, số bản sao, layer chứa 
nó, thuộc tính tự động dán mặt, luôn quay về camera … 

• Erase để xóa component trong mô hình. Hide để tắt hiển 
thị component. Lock dùng để khóa component, tránh tác 
động vô ý. 

• Edit Component để cô lập, 
đồng thời chuyển vào bối 
cảnh tương ứng để hiệu  
chỉnh component. Việc hiệu 
chỉnh đương nhiên ảnh 
hưởng tất cả các bản sao 
trong mô hình, trừ khi trước 
đó đã chọn Make Unique để 
tách component khỏi  sự 
ràng buộc với các bản sao 
khác (tạo thành 1 compo  
nent mới). 

• Explode để phá vỡ component thành các đối tượng rời. 

• Unglue dùng để hủy thuộc tính tự động dán mặt. 

• Reload cập nhật lại các thay đổi của file gốc vào 
component hiện tại. Kết hợp với thủ thuật import một mô 
hình vào mô hình khác ta có hiệu ứng tương tự xref. 

• Save As lưu component đang chọn thành file riêng.  

• Change Axes thay đổi điểm chèn của một component. 
Sau khi thay đổi các component trong thư viện “In Model” 
sẽ mang điểm chèn mới (component trong các thư viện 
khác không ảnh hưởng). 
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• Reset Scale/Reset Skew khôi phục lại tỉ lệ, hình dáng 
gốc của componetn khi thu phóng hay biến dạng một 
component bên ngoài bối cảnh của nó (không thông qua 
lệnh Edit Component). 

• Scale Definition cập nhật tỉ lệ mới của một component 
vào định nghĩa component. Sau khi cập nhật, các 
component đã chèn trước đó không thay đổi tỉ lệ nhưng 
các component từ lúc đó trở vể sau khi chèn vào mô hình 
sẽ mang tỉ lệ mới. 

• Intersect with Model thực hiện giao cắt component. 

• Flip Along lật component theo các trục của nó. 

• Zoom Extents phóng khít component lên khung nhìn. 

Menu động khi click phải lên component trong browser: 

• Properties dùng hiển 
thị và chỉnh một số 
thuộc tính tương tự như 
Entities Info, ngoại trừ 
các tính năng có thêm 
như: bật tắt tính năng 
Expand để thống kê 
thành phần hình học có 
tính tới componetn con 

hay không, nguồn load component … 

• Delete xóa component khỏi thư viện In Model cùng với tất 
cả các bản sao tương ứng trong mô hình. 

• Reload cập nhật thay đổi file nguồn vào component trong 
thư viện cũng như bản sao tương ứng trong mô hình. 

• Save As lưu thành file riêng 

• Select Instances chọn tất cả các bản sao tương ứng 
trong mô hình. 

• Replace Selected thay thế component đã chọn trước đó 
trong mô hình bằng component đang chọn trong thư viện. 

Click vào nút hình tam giác tô đen nằm ngang, góc trên bên phải 
hộp thoại để kích hoạt Details Menu với các tính năng:  

• Icon View/List View  duyệt component theo tên hay icon. 

• Refresh cập nhật component khi có thay đổi trong hệ 
thống. 

• Purge Unused xóa scomponent thừa trong mô hình. 

• Add to / Remove from Favorites tạo hay xóa các thư 
viện component cá nhân. 
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3. Component Outliner (Quản lí Outliner) 
Bật tắt hộp thoại qua menu Window/Outliner. Chức năng chính 
của Component Outliner là quản lí theo cấu trúc phả hệ 
(hierarchical tree) các group_component trong mô hình, rất hữu 
ích khi phải làm việc với 1 mô hình lớn và phức tạp. 

 Trong hộp thoại, click tên group_component để chọn, click 
đúp để mở bối cảnh tương ứng. Các thao tác khác có thể thực 
hiện thông qua menu động tương tự ngoài không gian vẽ. 

Với group_component có cấp độ con, dùng kí hiệu (+) hay (-) 
trước nó để thả hay cuộn từng nhánh phả hệ. Chọn Expand All 
hay Collapse All trong Details Menu để thả hay cuộn toàn bộ 
phả hệ. 

Có thể nhận dạng trạng thái mỗi group_component theo hệ 
thống kí hiệu hình_chữ sau (xuất hiện đầu mỗi nhánh phả hệ) 
 

Ý nghĩa Kí hiệu 

Component 4 điểm vuông đen đặc 

Group 1 điểm vuông đen đặc 

Component đã khóa 4 điểm vuông xám + ổ khóa 

Group đã khóa 1 điểm vuông xám + ổ khóa 

Component đang mở 4 điểm vuông xanh rỗng 

Group đang mở 1 điểm vuông xanh rỗng 

Component_Group ẩn Tên in nghiêng mờ 

 

Có thể cấu trúc lại các group_component trong phả hệ bằng 
cách xác định vị trí nguồn, vị trí, dùng chuột thao tác kéo thả. 

Có thể dùng bộ lọc các kí tự có trong tên group_component 
bằng cách gõ kí tự vào ô Filter đầu hộp thoại. 

 Cần phân biệt 2 loại: 
Instance name và 
Definition name. Các bản 
sao group_component cùng 
loại trong mô hình cùng chia 
sẻ một định nghĩa chung. Vì 
thế, các group_component 
cùng loại có thể mang nhiều 
instance name giống hoặc 
khác nhau nhưng chỉ có duy 
nhất 1 definition name. 

Instance name đứng đầu nhánh phả hệ còn Definition name nằm 
trong dấu ngoặc nhọn. 

 Sửa đổi instance name của group_component bằng cách 
chọn mục Rename trong menu động. Sửa đổi definition name 
thông qua mục Entity Info trong menu động. 

Đầu tư cho việc đặt instance name, definition name cũng quản lí 
cấu trúc phả hệ group_component ngay từ đầu mang lại hiệu 
quả rất lớn trong việc cập nhật mô hình sau này. 
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4. Model Settings and Managers (Thiết lập và 
quản lí mô hình) 
 

4.1 Model Info Dialog Box 

Kích hoạt qua menu Window/Model Info. Có chức năng quản lí 
các tham số toàn cục ảnh hưởng đến mô hình, mang yếu tố “đồ 
họa”. Các đề mục theo thứ tự 

4.1.1 Colors : điều khiển màu sắc hiển thị của các thành phần 
trong không gian vẽ như Edge (cạnh), Face front/Face back (mặt 
trước/sau) Hightlight (màu đánh dấu chọn), Constr lines (màu 
nét trục), Lock (màu đối tượng bị khóa). 

 Lưu ý mục Background, Sky, Ground cho chọn màu 
phông nền, màu trời, màu mặt phẳng ngang. Thang trượt 
Transparency và mục Show ground from below điều chỉnh 
chế độ hiển thị khối nằm dưới mặt phẳng nền OXY và nhìn 
ngược dưới đáy nền lên. 

4.1.2 Component : điều khiển hiển thị của các group, 
component trong không gian vẽ.  

Thang trượt Fade similar component chỉnh độ mờ của các bản 
sao còn lại khi mở bối cảnh của một trong số chúng. Có thể 
check mục Hide để ẩn các bản sao còn lại. 

Thang trượt Fade rest of model chỉnh độ mờ của phần mô hình 
còn lại khi mở bối cảnh của một group, component. Có thể check 
mục Hide để ẩn phần mô hình còn lại. 

Có thể check Show component axes để hiển thị hệ trục của 
mỗi group, component. 

4.1.3 Dimension : điều khiển 
hiển thị toàn cục các đường 
kích thước.  

Mục Text cho chọn kiểu, cỡ và 
màu của chữ số kích thước. 
Check mục Show radius/diam 
prefix để hiển thị tiền tố bán 
kính, đường kính. 

Mục Leader Lines cho chọn 
kiểu nhấn đầu đường kích thước và đường dóng với các tùy 
chọn None, Slash, Dot, Closed và Open như hình vẽ mô tả  

Mục Dimension với tùy chọn Horizontal to screen hoặc Align 
to dimesion line qui định chữ số kích thước luôn đối diện với 
khung nhìn hay luôn nằm trên đường kích thước. 

Các thang trượt Hide when foreshorten,  Hide when too small 
điều chỉnh ngưỡng ẩn đường kích thước khi quá ngắn hoặc 
khung nhìn thu lại quá nhỏ. 

Mục Troubleshooting cho tùy chọn điểm sáng những đường 
kích thước vô định, không bắt vào đối tượng. 
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4.1.4 File : chứa các thông tin về thuộc tính file đang vẽ như tên, 
dung lượng, địa chỉ thư mục, mô tả …  

Mục Alignment cho chọn trước tính năng tự động dán mặt, luôn 
quay về phía khung nhìn, bóng đổ bất biến … để có thể chèn file 
hiện hành vào như một component trong file khác. 

4.1.5 Location : giả lập địa điểm đặt mô hình với các địa danh 
cho trước hoặc tự thiết lập theo tọa độ địa lí. Có thể chỉ định 
hướng Bắc trong mục Solar Orientation. Hộp thoại Location rất 
quan trọng khi muốn giả lập bóng đổ chính xác cho mô hình. 

4.1.6 Section Planes : cho phép hiệu chỉnh độ dày nét cắt, màu 
nét cắt, màu của mặt phẳng cắt hiện hành và không hiện hành. 

4.1.7 Statistics : thống kê các đối đượng hình học trong mô 
hình. Tùy chọn xóa các đối tượng thừa Purge unused và sửa 
các lỗi hình học Fix errors 

4.1.8 Text : điều khiển hiển thị toàn cục các chú thích.  

Mục Text cho chọn kiểu, cỡ và màu của chữ ghi chú. 

Mục Leader Lines với 
tùy chọn End point cho 
các kiểu đầu mũi tên 
chú thích như None, 
Slash, Dot, Closed Arrow và Open Arrow như hình vẽ mô tả.  
Tùy chọn Leader  qui định hiển thị chú thích theo kiểu View 
Based (luôn giữ trạng thái 2 chiều của chữ) và Pushpin (quay 
chữ trong không gian tùy theo khung nhìn). Tùy chọn Select all 
text và Update selected text để chọn tất cả đối tượng text trong 

mô hình, thay đổi thuộc tính rồi áp dụng thay đổi cho tất cả các 
đối tượng text đã chọn. 

4.1.9 Tourguide : qui định thời gian chuyển động của mỗi khung 
nhìn và thời gian chuyển đổi giữa các khung nhìn khi làm slide 
trình chiếu. 

4.1.9 Units : qui định hệ đơn vị toàn cục của mô hình. Đơn vị đã 
chọn trong hộp thoại này sẽ trở thành mặc định, không cần nhập 
kèm đơn vị trong VCB. Tuy nhiên, vẫn có thể chỉ định đơn vị bất 
kì cho một giá trị cụ thể, nếu cố tình nhập kèm đơn vị đó trong 
VCB. 

4.2 Entity Info Dialog Box 

Kích hoạt que menu 
Window/Entity Info. Không 
thể khái quát do rất linh động 
và hoàn toàn phụ thuộc vào 
đối tượng được chọn trước 
khi kích hoạt. Hộp thoại này 
mang tính “hướng đối 
tượng”, ứng dụng tùy lúc, tùy sự linh động của người dùng. 

 

4.3 System Preferences Dialog Box 

Kích hoạt qua menu Window/Preferences. Có chức năng quản 
lí các tham số toàn cục ảnh hưởng đến môi trường làm việc của 
phần mềm SketchUp, mang yếu tố “kĩ thuật” 
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4.3.1 Drawing : với các tùy chọn cho kiểu click chuột, kiểu vẽ 
liên hoàn, hiển thị dây tóc … với mục đích dung hòa thói quen 
sử dụng các phần mềm đồ họa khác nhau trước đó. 

4.3.2 Extensions : Tắt, bật các nhóm công cụ nâng cao trong 
SketchUp như Ruby Script, Utilities Tools (Creat Face và Query 
Tool), Sandbox Tools. 

4.3.3 Files : lưu giữ đường dẫn các thư mục chuẩn. 

4.3.4 General : qui định chế độ lưu bản backup, thời gian tự 
động lưu, chế độ tự động kiểm tra lỗi hình học khi mở file … 

4.3.5 OpenGL : qui định các thiết lập về chuẩn OpenGL. Không 
nên hiệu chỉnh phần này nếu không nắm chắc, vì nó can thiệp 
sâu vào chế độ hiển thị của SketchUp. 

4.3.6 Shortcuts : dùng đặt phím tắt cho hệ thống. Rất hữu ích 
để nâng cao tốc độ vẽ. Mục Function liệt kê tất cả các lệnh theo 
menu, mục Assigned báo cho biết lệnh đó đã được gán phím 
tắt nào trước đó 
chưa. Nếu ô assigned 
còn trống có thể gán 
phím tắt  mới trong ô 
Add Shortchut 

 Click dấu (+) và 
(-) để gán và gỡ phím 
tắt trong ô tương ứng. 
Có thể dùng phím 

đơn hay tổ hợp phím để gán. Nên ưu tiên phím đơn cho các lệnh 
thường dùng nhất. Tổ hợp phím nên có tính gợi nhắc. 

 Không đặt 2 phím tắt cho 1 lệnh hoặc 1 phím tắt cho 2 lệnh. 

 

 Hệ thống phím tắt có thể thiết lập riêng tùy theo mỗi người 
dùng trên cùng một máy (nếu sử dụng mạng và phân quyền 
đăng nhập).  

Hệ thống phím tắt có thể xuất_nhập thông qua file .dat bằng 
cách click nút Import_Export, rất hữu ích để di chuyển hoặc 
thống nhất hệ thống phím tắt giữa các máy, giữa các người dùng 

4.3.7 Template : dùng mở một file mẫu có sẵn khi cần vẽ mới 
một mô hình. Mặc định SketchUp có sẵn các file mẫu ứng với 
các hệ đơn vị : Architectural – US, Centimeter, Meter, Millimeter. 

Cũng có thể tải một file SketchUp đã có làm file mẫu bằng cách 
click vào nút Browser. 

Các file Template nên chép vào thư mục C:\.Program Files\ @ 
Last Solfware\SketchUp 5\Templates. 
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 1. Ánh sáng 
Trong SketchUp chỉ có khái niệm về ánh sáng trực tiếp ban ngày 
với đặc thù phân định các mảng bóng đổ, mảng sáng tối không 
có vùng mờ chuyển tiếp. Ánh sáng nhân tạo, hiệu ứng ánh sáng 
chuyên sâu không được phát 
triển trong  SketchUp. 

Các thiết lập cơ bản về ánh 
sáng nằm trong hộp thoại 
Window/Shadow Settings 
hoặc truy cập nhanh trên 
nhóm công cụ với các mục 
chính 

• Display Shadow bật, 
tắt chế độ hiển thị ánh sáng. Nên tắt đi khi đang dựng 
hình. 

• Time Chọn giờ trong ngày.  

• Date Chọn ngày trong năm 

• Light chỉnh cường độ sáng của mảng sáng 

• Dark chỉnh cường độ sáng của mảng tối 

• On face bật tắt chế độ đổ bóng lên vật khác 

• On ground bật tắt chế độ đổ bóng lên nền 

• From edges bật tắt chế độ lấy bóng đổ của đường nét 

 Các thiết lập này mang tính toàn cục ảnh hưởng tất cả các 
đối tượng. Nếu muốn một số đối tượng có hay không có bóng 
đổ, có thể thiết lập qua hộp thoại Entity Info của từng đối tượng. 

Muốn giả lập ánh sáng như địa điểm thực cần kết hợp với 
mục Location trong hộp thoại Model Info đã trình bày chương 
trước. Muốn giả lập ánh sáng như thời gian thực cần kếp hợp với 
kĩ năng làm slide show sẽ được trình bày sau. 

 Trong SketchUp, vật trong suốt dưới ngưỡng 70% sẽ không 
có bóng đổ cũng như không nhận bóng đổ từ vật khác. 

 
2. Vật liệu 
2.1 Material Browser 
(Chọn vật liệu) 

Khi chọn công cụ Paint 
Bucket, hộp thoại Material 
Browser sẽ tự động kích hoạt 
để thao tác chọn màu hoặc vật 
liệu, sau đó click lên đối tượng 
để gán màu hoặc vật liệu vừa 
chọn.  

V. AÙNH SAÙNG, VAÄT LIEÄU, HIEÅN THÒ 
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• Material swatch ô thể hiện mẫu vật liệu hiện hành, nằm 
góc trên bên trái hộp thoại. 

• Library tab các nhóm thư viện màu, vật liệu có sẵn trong 
SketchUp hoặc browse tới thư viện cá nhân người dùng. 

• In Model tab các vật liệu đang dùng trong mô hình. 

• Create/Edit nút tạo mới / chỉnh vật liệu thông qua hộp 
thoại Material Editor. Có thể chọn lệnh Edit nhanh bằng 
cách click đúp vào mẫu vật liệu. 

Các tính năng khác trong Details Menu của hộp thoại 

• Display Size chỉnh cỡ hiển thị mẫu vật liệu trong browser 

• Insert Material chèn vật liệu hiện hành trên material 
swatch vào nhóm thư viện hiện hành trong browser. 

• Purge Unused xóa các vật liệu thừa trong mô hình. 

• Clear/Open/Merge Library xóa, mở, ghép thư viện. 

• Sort by Name mặc định SketchUp sắp xếp vật liệu trong 
một thư viện theo sắc thái màu, chọn mục này để sắp 
theo tên. 

• Save/Save As Library lưu lại các thay đổi hoặc lưu thư 
viện hiện hành thành thư viện mới. 

 Ngoại trừ vật liệu đơn thuần màu sắc, các vật liệu có sử 
dụng mẫu tô thường có dung lượng khá lớn. Nên thường xuyên 
sử dụng tính năng Purge Unused. 

Kích hoạt menu động của một mẫu tô trong browser, chọn 
Area để biết tổng diện tích của vật liệu đó trong mô hình. 

Vẫn còn một số tính năng linh hoạt khác nằm trong menu động 
của mẫu vật liệu trong Library tab và In Model tab phục vụ cho 
các phương pháp vẽ khác nhau của mỗi người. 

 Không nên tùy tiện thay đổi nội dung, cấu trúc các nhóm 
thư viện chuẩn của SketchUp, thay vào đó, hãy Save As chúng 
thành thư viện cá nhân trước khi thiết lập các tùy biến. 

 

2.2 Material Editor (Chỉnh mẫu vật liệu) 

Hộp thoại Material Editor luôn xuất hiện khi tiến hành tạo mới, 
hiệu chỉnh vật liệu hoặc khi click đúp vào mẫu vật liệu bất kì. Các 
tính năng của hộp thoại 

• Material Name tên vật 
liệu. 

• Material loại vật liệu. 

• Color Picker xóa các vật 
liệu thừa  trong mô hình. 

• Undo Color Changes 
xóa, mở, ghép thư viện. 

• Match Color of Object 
in Model lấy mẫu vật liệu từ đối tượng trong mô hình áp 
lên vật liệu đang chỉnh sửa. 
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• Match Color from Library Sample  lấy mẫu vật liệu trong 
thư viện áp lên vật liệu đang chỉnh sửa 

• Use Texture Image - Texture File bật tắt tính năng dùng 
hình ảnh làm mẫu tô. Chỉ định file ảnh sẽ lấy làm mẫu tô 

• Reset Color  trả lại trạng thái màu sắc ban đầu của mẫu 
vật liệu, trước khi chỉnh sửa  

• Colorize chức năng đồng bộ sắc thái màu, giúp cho việc 
chỉnh sửa màu sắc không làm thay đổi tương quan 
nguyên thủy giữa các màu với nhau. 

• Dimensions điều chỉnh kích thước hiển thị mẫu tô dùng 
trong mô hình 

• Lock/Unlock Aspect Ratio khóa-mở khóa tỉ lệ ngang-
dọc của mẫu tô 

• Opacity điều chỉnh độ trong suốt của vật liệu, độ trong 
suốt dưới ngưỡng 70% sẽ không có bóng đổ. 

• Add thêm một mẫu vật liệu vừa chỉnh sửa vào thư viện 

2.3 Position Texture Tool (Tô vật liệu trong 3D) 

Ngoài nhu cầu hiệu chỉnh bề mặt hiển thị vật liệu, ta còn có nhu 
cầu hiệu chỉnh cách áp vật liệu trong không gian cũng như biến 
hình cách áp đó. Thao tác chung 

Click phải bề mặt đã được tô vật liệu > Texture > Position > 
Thao tác hiệu chỉnh > Kế thúc bằng mục Done trong menu động 
hoặc phím Enter hoặc click ra vùng trống 

Vật liệu sẽ được hiển thị dưới dạng lưới đơn vị, một trong số 
chúng hiển thị 4 điểm neo. Có 2 loại neo 

Neo cố định (Fixed Pin) khi thao tác vẫn giữ tương quan với các 
điểm neo còn lại. Dùng thu phóng, di chuyển, quay mẫu tô … 
bảng icon và tính năng như sau 

 

Icon neo cố định Tính năng 

 
Click rê chuột để di chuyển mẫu tô. 

 
Click rê chuột theo góc đồng hổ để scale, rê 
chuột vòng tròn để xoay mẫu tô 

 
Kéo xiên mẫu tô theo hình bình hành 

 
Hiệu chỉnh độ méo phối cảnh của mẫu tô 

Neo tự do (Free Pin) 
khi thao tác không giữ 
tương quan với các 
điểm neo còn lại. Dùng 
hiệu chỉnh độ méo phối 
cảnh của mẫu tô 

 

 Click đơn lên neo 
để di chuyển vị trí neo 

trên mẫu tô. Lưu ý neo cố định thích hợp với các mẫu tô có qui 
tắc như gạch, ngói. Neo tự do thích hợp với mẫu tô là ảnh nền. 

 Các tính năng trong menu động của neo cố định, neo tự do 
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Fixed Pin chuyển đổi qua lại giữa 2 loại neo 

Done kết thúc thao tác hiệu chỉnh và lưu kết quả. Tương đương 
click chuột ra khoảng trống để kết thúc lệnh, lưu kết quả. 

Reset khôi phục trạng thái trước khi chỉnh sửa. Tương đương 
phím Ecs trong để thoát khỏi lệnh, không lưu kết quả 

Flip lật mẫu tô theo phương ngang hoặc đứng 

Rotate xoay mẫu tô các góc 90,180,270 độ 

Undo/Redo phục hồi thao tác tới hoặc lui từng bước, hhác với 
Undo/Redo toàn cục 

Khi tô một ảnh nền lên mặt gấp khúc, mỗi mặt sẽ nhận tọa 
độ ảnh riêng biệt, không liền mạch. Để tô hình nền liền 

mạch qua các mặt gấp khúc thao tác như sau: 

• Tô mặt đầu tiên như thông thường 

• Click phải mặt vừa tô > Texture > Position nhưng không 
chỉnh gì cả. Sau đó chọn Done 

• Chuyển công cụ Paint Bucket, dùng phím Alt lấy mẫu ảnh 
nền trên mặt vừa tô. 

• Tiến hành tô các mặt tiếp theo, ảnh nền sẽ liền mạch trên 
các mặt sau đó. 

Tính năng này ứng dụng khi cần tô ảnh một dòng chữ liền mạch 
qua các mặt gấp khúc chẳng hạn. 

 Thao tác hiệu chỉnh cách tô không có tác dụng với vật liệu 
trên mặt cong. Nếu muốn, phải hiện thị các nét khuất chia mặt 
cong (View/Hidden Geometry) rồi hiệu chỉnh trên từng mặt 
phẳng thành phần 

 
3. Hiển thị 
3.1 Quản lí trang màn hình (Pages) 

Trong SketchUp, có thể thiết lập nhiều trang màn hình (Pages), 
mỗi trang lưu giữ một kết quả hiển thị với các thiết lập tương 
ứng đi kèm. Thao tác quản lí page thực hiện thông qua hộp thoại 
Window > Pages  với các nội dung 

• Add/Delete thêm hoặc xóa 
một trang màn hình. Tên 
trang và mô tả trang có thể 
nhập vào mục Name và 
Description 

• Update lưu lại các thiết lập đi 
kèm với trang màn hình sau 
khi ta thay đổi. Các thiết lập 
này bao gồm các mục bên 
dưới hộp thoại (Properties to 
save) : camera, bóng đổ, ẩn-hiện, mặt cắt, kiểu hiển thị, 
hệ trục và layer. Chỉ có mục được đánh dấu mới lưu 
lại. 
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• Include in slideshow chỉ trang nào có đánh dấu mục này 
mới được tính vào chuỗi slideshow để làm hoạt cảnh. 

• Nút mũi tên lên xuống để điều chỉnh thứ tự trước sau của 
trang màn hình. Nút mũi tên thu gọn hộp thoại 

Sau khi khởi tạo trang màn hình đầu tiên, hàng trên cùng không 
gian vẽ xuất hiện thanh Page Tab mà qua đó có thể thao tác 
menu động với các nội dung 

• Add/Update/Delete có tính năng tương tự trong hộp thoại 

• Slideshow trình diễn hoạt cảnh tạm thời trên màn hình 

• Page Manager mở hộp thoại quản lí 

 Luôn lưu lại các thiết lập đi kèm mỗi khi thay đổi chúng, 
nếu không bạn sẽ phải thực hiện lại các thao tác hiệu chỉnh 

Trình tự Pages cũng là trình tự slideshow trong hoạt cảnh, 
thời gian lưu ảnh và chuyển động thiết lập trong hộp thoại 

Model Info, sau cùng xuất ra kiểu file thích hợp để có hoạt cảnh. 

3.2 Chế độ hiển thị (Display Settings) 

Trong SketchUp, kết quả hiển thị trên màn hình cũng chính là kết 
quả hiển thị của thành phẩm. Tất nhiên có thể dùng thêm các 
phần mềm đồ họa khác tác động lên thành phẩm nhưng khả 
năng này tương đối hạn chế. Vì thế, nên chủ động thiết lập hiển 
thị mong muốn ngay trong SketchUp thông qua hộp thoại 
Window > Display Settings với cấu trúc sau 

Hàng icon khối lập phương từ trái sang phải với các chế độ hiển 
thị cho mặt phẳng (Face Rendering)  

• X-Ray Mode làm cho tất cả 
các mặt phẳng trong 
SketchUp trong mờ, giúp 
thao tác với các đối tượng bị 
che khuất. Chế độ hiển thị 
này có thể kết hợp với tất cả 
các chế độ, hiệu ứng hiển thị 
khác (nêu dưới đây) 

• Wireframe hiển thị khung 
dây. Hiển thị tất cả các nét khuất và thấy. Không hiển thị 
mặt phẳng. Các công cụ thao tác mặt phẳng cũng không 
có tác dụng. 

• Hidden Line chỉ hiển thị mặt phẳng và nét thấy. Không 
hiển thị bóng đổ và vật liệu. Thích hợp để xuất bản vẽ nét 
sau đó vẽ tay hoặc xứ lí bằng các phần mềm khác. 

• Monochrome cũng là chế độ hidden line nhưng bật hiển 
thị bóng đổ. 

• Shaded hiển thị mặt phẳng, nét thấy và  bóng bản thân 
dưới ảnh hưởng của ánh sáng 

• Shaded with Textures hiển thị bóng bản thân và vật liệu. 
Chế độ này làm chậm tốc độ xử lí của phần mềm, không 
nên dùng khi đang vẽ. 
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Các tính năng hiển thị của cạnh (Edge Rendering) 

• Show Edges bật tắt hiển thị cạnh 

• Show Profile bật tắt hiển thị cạnh viền của đối tượng 
hoàn chỉnh trong 3D. Nhập độ dày nét bằng đơn vị pixel 

• Depth Cue hiệu ứng nhấn nét theo nguyên tắc gần đậm 
xa nhạt. Nhập độ dày nét gần điểm nhìn nhất bằng đơn vị 
pixel. 

• Jitter Lines hiệu ứng đồ một nét nhiều lần như vẽ tay. 

• Extension Lines hiệu ứng vẽ dư đầu nét. Nhập độ dài 
đoạn dư bằng đơn vị pixel 

• Endpoint hiệu ứng nhấn đậm đầu nét. Nhập độ dài đoạn 
nhấn đậm bằng đơn vị pixel 

Phối hợp các hiệu ứng nét và mặt phẳng với nhau, bạn sẽ 
có rất nhiều tùy chọn sáng tạo. 

Edge Colors cho các tùy chọn về màu sắc của nét 

• All Same chuyển tất cả các nét theo màu mặc định trong 
hộp thoại Model Info. Đây chỉ là màu hiển thị, không thật 
sự thay thế màu đã gán cho nét (nếu có) 

• By Material hiển thị nét theo màu đã gán cho nó. Vì trong 
SketchUp bạn có thể tô màu cho nét. 

• By Axis hiển thị nét theo 3 màu của 3 trục hiện hành mà 
nó song song. Tính năng này rất hữu ích để phát hiện các 
nét không song song với hệ trục hiện hành 

Các tính năng bổ sung cho hiển thị mặt (Additional Face 
Rendering Options) 

• Use sun for shading cố định bóng bản thân theo mặt 
trời. Nếu không chọn tính năng này, bóng bản thân thay 
đổi bất kì theo vị trí camera. 

• Enable Transparency bật tắt hiệu ứng của vật liệu trong 
suốt với 3 mức độ ưu tiên tăng dần cho diễn họa nhưng 
chậm dần cho tốc độ xử lí: Faster, Medium, Nicer 

3.3 Độ trơn hiển thị (Soften/Smooth Edges) 

Tính năng Soften/Smooth Edges điều chỉnh độ chi tiết của mặt 
cong. Độ trơn thấp, mặt cong thể hiện như tập hợp các mặt 
phẳng rõ  nét. Độ trơn càng cao, 
mặt cong càng mịn, nét mất dần. 
Truy nhập hộp thoại 
Soften/Smooth Edges thông qua 
menu động trong khi vẽ là cách 
nhanh nhất. Các tùy chọn 

• Angle between normals ngưỡng giới hạn của góc giữa 
hai mặt phẳng sẽ bị làm trơn. Tất cả các mặt phẳng hợp 
với nhau góc nhỏ hơn hoặc bằng trị số này sẽ bị làm trơn 

• Soften coplanar làm trơn, xóa nét giữa nhóm các mặt 
phẳng hay gần như phẳng. 

Khi làm trơn, các nét không thật sự bị xóa mà chỉ ẩn đi. Có thể 
hiển thị chúng dưới dạng nét đứt qua menu View > Hidden 
Geometry 
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3.4 Tinh chỉnh khung nhìn 

Nhóm công cụ quan sát cơ bản (Camera Tools) đủ hỗ trợ dựng 
và hiệu chỉnh hình. Nhưng trước khi xuất ra thành phẩm cần trải 
qua vài thao tác tinh chỉnh. 

 

Position Camera (Định vị camera) 

Chọn công cụ, độ cao tầm mắt tự động thiết lập 5 feet, 6 inches 
(tương ứng 1676mm).  

Click chuột bất kì trong không gian vẽ để xác lập khung nhìn 
không điểm đích. Hoặc click > giữ chuột > kéo xác định tia nhìn 
và đích đến > thả chuột để thiết lập khung nhìn có điểm đích. 

Có thể điều chỉnh độ cao tầm mắt trong VCB trước hay sau khi 
định vị. Có thể dựng trước các đường trục (construction line) để 
định vị chính xác camera 

 

Hiệu chỉnh trường nhìn phối cảnh 

Kích hoạt công cụ zoom > Thanh VCB hiển thị tiêu đề Field of 
View cho phép thay đổi trường nhìn phối cảnh thông qua 
đơn vị (deg) của góc nhìn hoặc (mm) của tiêu cự ống kính 

tùy theo đơn vị nhập vào. Mặc định là đơn vị góc. 

Look Around (Nhìn quanh) 

Công cụ này dùng để quay camera 360 độ trên chân 
chống cố định, tương ứng việc đảo mắt nhìn bao quát. 

Sau khi kích hoạt công cụ thì rê chuột để thao tác. 

 

3.5 Slideshow và Animation 

Có thể xem hiệu ứng chuyển động quanh công trình như thế nào 
qua công cụ Walk. Nhưng nhìn chung công cụ này còn thiếu tiện 
lợi trong điều khiển và hiệu quả mang lại không bằng slideshow. 
Nguyên tắc thực hiện 

• Tổ chức thật tốt trình tự và các thiết lập hiển thị của 
Pages. Trình tự, thiết lập của page chính là kết quả sẽ thể 
hiện trong slideshow và animation. 

• Số Pages càng ít càng tốt. Chỉ tạo page ở các điểm nút 
thay đổi về kịch bản hoặc hiển thị 

• Thiết lập thời gian lưu trang màn hình và thời gian lưu 
ảnh hợp lí. 

• Thiết lập kiểu nén video, số khung hình trên giây và độ 
phân giải khung hình thật hợp lí 

Khi đã đảm bảo tốt các nguyên tắc trên, chỉ còn việc xuất ra định 
dạng video rất đơn giản qua menu File > Export > Animation. 
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A - Thuật ngữ hỗ trợ 

Tính chất công việc tuy khác với giới tin học nhưng có những 
kiến thức thuộc diện “phổ cập” mà kiến trúc sư nên hiểu biết 
nguyên lý cơ bản của nó. 

1. Ảnh điểm (Raster images)  

a. Khái niệm: ảnh điểm được cấu thành từ các điểm hình vuông 
mang thông tin màu sắc riêng biệt (pixels). Khi ghép sát các 
điểm với nhau theo một trật tự ngang và dọc sẽ thể hiện nội 
dung ảnh. Lưu ý: 

• Kích thước ảnh lớn, số pixels càng nhiều, dung lượng tập 
tin càng lớn, ảnh càng rõ nét và màu sắc trung thực. 

• Không thể tăng kích thước ảnh lớn hơn số điểm ảnh thực 
tế có được mà không làm giảm chất lượng ảnh. 

b. Vài loại file ảnh điểm 

JPEG (Joint Photographic Expert Groups): cực kì phổ biến hiện 
nay do khả năng nén rất cao, giảm dung lượng tối đa, rất thích 
hợp cho việc truyền gởi ảnh giữa các thiết bị, email và xem trên 
trang web. Việc nén ảnh sẽ lược bỏ dữ liệu, giảm chất lượng 
ảnh một cách không thể hồi phục. 

PNG (Portable Network Graphics): Phổ biến tương tự chuẩn 
JPEG nhưng việc nén ảnh không làm mất dữ liệu điểm ảnh. 
Thận trọng khi dùng chuẩn PNG cho mô hình thô trong 
SketchUp (mô hình chưa có mẫu tô – texture) 

TIFF (Tagged Image File Format): Kém thông dụng do có quá 
nhiều chuẩn TIFF và không tương thích hoàn toàn giữ các hệ 
thống khác nhau. Thường dùng khi in ấn với độ phân giải cao. 

BMP (Bitmap): nguyên thủy được phát triển cho Clipboard của 
hệ điều hành Microsoft Windows. Các ứng dụng dễ dàng tiếp 
cận chỉnh sửa. Dung lượng rất lớn, không thich hợp cho môi 
trường truyền dữ liệu và lưu trữ. 

TGA (Truevision Advanced Raster Graphics Adapter or Tagar): 
chuẩn TGA phát triển bởi hãng AT&T dùng kém với “Truevision 
video boards” mang lại độ phân giải cao và tính tương thích màu 
cho máy tính cổ lỗ sĩ thời kì đầu. Ngày nay, mọi máy tính cá 
nhân với bo mạch đồ họa đầy năng lực có thể quên đi bo mạch 
Targar. Tuy vậy, chuẩn TGA vẫn được sử dụng bởi tính chất 
nén không mất dữ liệu, ổn định và có hỗ trợ kênh alpha. 

Epix: chuẩn riêng của chương trình Piranesi, một chương trình 
diễn họa kiến trúc. 

PHUÏ LUÏC 
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2. Ảnh vectơ (Raster images)  

a. Khái niệm: nội dung ảnh được lưu trữ, thể hiện qua thông số 
các vectơ hình học và thông số về màu. 

• Dung lượng ảnh vectơ thường rất nhỏ. 

• Từ một file ảnh vectơ có thể xuất ra các độ phân giải bất 
kì mà chất lượng ảnh vẫn được giữ nguyên 

b. Vài loại file ảnh vectơ 

EPS (Encapsulated PostScript): xây dựng trên chuẩn PostScript 
của hãng Adobe, là chuẩn giao tiếp giữa các chương trình và 
máy in, được sử dụng rộng rãi trong công nghiệp in và đồ họa 

PDF (Portable Document Format): cực kì phổ biến trong hoạt 
động trao đổi ấn bản điện tử trên Internet. Chuẩn PDF bảo lưu 
font chữ, định dạng, đối tượng đồ họa của văn bản gốc, đặc biệt 
lưu ý đến chương trình và hệ thống đã tạo ra văn bản gốc. Bất kì 
ai sử dụng phần mềm Adobe Reader (miễn phí) cũng có thể chia 
sẻ, tiếp cận, in ấn một cách chính xác như ý các tài liệu PDF. 

Lưu ý: nhiều yếu tố của một mô hình SketchUp như mẫu tô 
(texture), bóng đổ (shadow), bóng bản thân (smooth shading), 
hậu cảnh (background), xuyên sáng (transparency) không thể 
xuất sang chuẩn PDF và EPS. 

DWG (AutoCAD Drawing File): chuẩn của phần mềm AutoCAD 
phát triển bởi hãng Autodesk với nhiều phiên bản khác nhau 
(R12,R14,R2000,R2004). 

DXF (Data Exchange File): chuẩn đồ họa 2D được hỗ trợ bởi 
hầu hết các ứng dụng CAD trên nền Macintosh và PC, nên dùng 
để trao đổi dữ liệu giữa các ứng dụng CAD khác nhau. 

3. Hoạt cảnh (Animation)  

a. Khái niệm: hoạt cảnh thực chất là một loạt các ảnh vectơ 
hoặc ảnh điểm có liên hệ với nhau phát lại theo thời gian thực. 
Chất lượng và dung lượng hoạt cảnh hoàn toàn phụ thuộc vào 
thời gian chiếu, thuật toán nén, số khung hình/giây và kích thước 
khung hình. 

b. Vài chuẩn nén video trong SketchUp 

CinepakCodec by Radius: chuẩn mặc định trong SketchUp. Dù 
không mới mẻ nhưng cho ra những đoạn film đáng tin cậy, chạy 
suôn sẻ trên bất kì hệ thống nào cũng như trên CD-ROM, nén 
lượng tốt. Cinepak là chuẩn nén bất đối xứng và lược bỏ dữ liệu 
khung hình. 

Intel Indeo Video R3.2: chuẩn thiết kế riêng cho việc chạy file 
video từ đĩa CD-ROM, tính chất tương tự Cinepak nhưng ít phổ 
biến hơn. 

Microsoft Video 1: thiết kế riêng cho Window 3.1, chất lượng 
không cao và ngày nay rất hiếm khi sử dụng. 

Intel Indeo Video 4.2 - Intel Indeo Video 5.10: chuẩn nén video 
lược bỏ dữ liệu khung hình, tốc độ, linh hoạt, tương thích tốt với 
một chất lượng ảnh trung bình. Việc khai thác đôi khi đòi hỏi các 
phần mềm chuyên biệt của Intel. 
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Full Frame Uncompressed: xuất hoạt cảnh trọn vẹn, không thực 
hiện bất kì việc nén dữ liệu nào. Nên xuất hoạt cảnh dạng này 
trước khi tiến hành trích xuất các phương án chất lượng khác 
nhau. 

4. Chỉnh màu sắc trong SketchUp (Color Picker): được hỗ trợ 
hạn chế theo hệ màu HSB (Hue, Saturation, Brightness), HLS 
(Hue, Light, Saturation)  và RGB (Red, Green, Blue). Điều này 
cho thấy việc in ấn không phải là mục tiêu hướng tới của 
SketchUp. Để có được ấn bản sau cùng, chúng ta phải kết hợp 
xử lí với các công cụ đồ họa khác. 

5. Ruby API: bạn có thể sử dụng ngôn ngữ lập trình Ruby để 
xây dựng thêm các tiện ích, menu, macro, plug-in … cho 
SketchUp theo chuẩn API (Application Programming Interface). 
Ruby là một ngôn ngữ lập trình hướng đối tượng mới do Nhật 
Bản phát triển. 

Bản thân SketchUp cũng tích hợp khả năng truy cập trực tiếp cú 
pháp ngôn ngữ Ruby trong một cửa sổ console. Việc khai thác 
Ruby API trong SketchUp có ý nghĩa tương tự như AutoLISP 
trong AutoCAD. 

7. OpenGL: cũng như các ứng dụng 3D khác, SketchUp đòi hỏi 
tài nguyên hệ thống khá cao. Bên cạnh bộ vi xử lý mạnh (CPU) 
và bộ nhớ RAM đủ lớn, bạn nên có bo mạch đồ họa mạnh và 
trình điều khiển bo mạch hỗ trợ 100% chuẩn OpenGL. 

OpenGL là một chuẩn công nghiệp sử dụng trong hầu hết các 
ứng dụng và trò chơi có nhu cầu thể hiện hình học không gian. 
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B - Thuật ngữ dùng trong SketchUp 

Autofold: việc chọn một điểm thuộc cạnh hoặc mặt của một đối 
tượng hình học, di chuyển chúng, dẫn đến kết quả đối tượng 
hình học bị xô kéo, vặn xoắn hay gập. 

Component: là một trong các thành tố hình học của SketchUp, 
có thể bao gồm các thành tố khác. Có thể sử dụng lại nhiều lần 
giữa các mô hình hoặc trong cùng mô hình. Thuộc tính các 
Component tham chiếu với nhau nên có thể áp dụng việc thay 
đổi hàng loạt. 

Construction Tools: các công cụ hình học chuẩn, đảm bảo các 
đại lượng trong xây dựng. 

Context: bối cảnh. Là khái niệm cô lập hóa các thành tố hình 
học theo từng cấp độ phả hệ. Khi chạy SketchUp, mặc định bạn 
đang làm việc trong “model context”. Khi tạo Component hoặc 
Group đồng thời bạn đã tạo context con của model context và có 
thể tiếp tục có các context nhỏ hơn nữa nếu bạn tiếp tục tạo 
Group trong Group, Component trong Component. Hầu hết các 
thao tác lệnh của bạn chỉ có giá trị trong context hiện hành. 

Context Menu: menu động có nội dung tùy theo bối cảnh. Kích 
hoạt context menu bằng cách chọn đối tượng và click phải. 

Default Material: vật liệu mặc định, mặc nhiên gán cho tất cảc 
các mặt phẳng tạo mới trong SketchUp cho đến khi bạn thay đổi 
vật liệu của mặt phẳng đó. Với vật liệu mặc định, mặt trước và 
mặt sau của 1 mặt phẳng được hiểu là khác nhau. 

Drawing Tools: các công cụ dùng để vẽ các thành tố hình học 
(entities) trong SketchUp. 

Entity: các thành tố hình học tạo nên một mô hình. 

Group: nhóm. Là một trong các thành tố hình học của 
SketchUp, có khả năng chứa đựng các thành tố khác. Việc chia 
nhóm hay giữ trạng thái “sticky” cần cân nhắc theo chiều hướng 
có lợi nhất cho mô hình. 

Ground Plane: mặt phẳng nằm ngang tượng trưng cho mặt đất. 
SketchUp qui ước mặt phẳng OXY tuyệt đối là Ground Plane, 
mọi cao độ đều được so với Ground Plane. 

Healing: hàn 2 mặt phẳng đồng phẳng riêng rẽ bằng cách xóa 
phân tuyến. 

Inference: nội suy trong SketchUp, khi dùng kèm tính năng khóa 
hướng sẽ rất hữu dụng cho việc dựng hình. 

Insertion Point: điểm chèn của component 

Layer: lớp đối tượng điều khiển việc hiển thị, hệ thống hóa các 
đối tượng trong mô hình. Layer trong SketchUp tương tự layer 
trong AutoCAD với các thuộc tính Tên, Màu, Hiển thị nhưng 
không có Kiểu nét và Độ dày nét. 

Layer Manager: hộp thoại quản lí hệ thống layer trong mô hình. 

Origin: điểm gốc hệ trục tọa độ trong SketchUp 

Page: trang hiển thị. Giống như khái niệm “slice” trong các ứng 
dụng trình chiếu. Mỗi trang hiển thị chứa mô hình hiện hành và 
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các thiết lập hiển thị như điểm nhìn, bóng đổ, kiểu hiển thị và 
mặt cắt. Các trang hiển thị có thể kết hợp với nhau tạo thành 
hoạt cảnh trình diễn TourGuide. 

Principal Tool: các công cụ cơ bản trong SketchUp. 

Ruby Console: môi trường mở rộng trong SketchUp, nơi bạn có 
thể thao tác cú pháp ngôn ngữ Ruby 

Ruby Programming Language: một loại ngôn ngữ lập trình 
hướng đối tượng. 

Ruby Script: những đoạn mã chương trình nhỏ viết bằng ngôn 
ngữ Ruby, mục đích thêm các tính năng tuỳ biến cho SketchUp 

Sandbox: mặt đã được tam giác hóa, giống như sân cát, 
thường dùng để vẽ địa hình trong SketchUp. Có thể tạo Sanbox 
bằng nhóm công cụ Sandbox Tools. 

Section Plane: mặt phẳng cắt dùng để định vị, định hướng nhát 
cắt trong mô hình. 

Section Slice: vết cắt. Là giao tuyến giữa mặt phẳng cắt và đối 
tượng bị cắt. 

Split: chia một mặt phẳng thành 2 hay nhiều phần khác nhau 
bằng cách vẽ trên đó 1 hay nhiều đoạn thẳng 

Sticky - Stickiness: trạng thái các đối tượng dính vào nhau, khi 
di chuyển thành phần này sẽ biến dạng thành phần dính với nó. 

Three-Point Perspective: phối cảnh 3 điểm tụ. 

TIN (Triangulated Irregular Network): mặt địa hình đã tam giác 
hóa. Mặt TIN có thể xem như Sandbox hoặc Mesh. 

Two-Point Perspective: phối cảnh 2 điểm tụ, tất cả các đoạn 
song song trục Z (Xanh) đều vuông góc với mặt phẳng ngang. 

Value Control Box: hộp nhập – hiển thị trị số trong khi vẽ, nằm 
góc dưới bên phải màn hình giao diện SketchUp 

Walkthrough Tool: công cụ giả lập việc đi bộ xung quanh và 
bên trong mô hình 

X-Ray Mode: chế độ hiển thị mà tất cả các mặt trong mô hình 
đều xuyên sáng. Rất hữu dụng để xem và chỉnh sửa các phần bị 
che khuất bên trong hoặc phía sau của mô hình. 
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